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About this guide

This guide provides information for the configuration and implementation of Infor CloudSuite Industrial
in a multi-tenant cloud environment.

Intended audience
This guide is intended for the system administrator, consultant, or business partner who configures
CloudSuite Industrial for use with Infor Operating Service (OS) in the cloud.

Contacting Infor
If you have questions about Infor products, go to the Infor Xtreme Support portal.

If we update this document after the product release, we will post the new version on this website. We
recommend that you check this website periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 1: Configuration checklist

Contact Infor Consulting Services for a checklist to complete the integration of the components in this
CloudSuite.
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Chapter 2: Configuration overview

Before you complete the configuration tasks, you must understand what is provided in the CloudSuite
and how the components of the CloudSuite communicate. You should also be familiar with a list of
related concepts and definitions.

About the CloudSuite
See the Infor CloudSuite Industrial Solution Overview - Cloud Edition for information about the
applications that are included or optional with this CloudSuite, and the applications that can be integrated
with the CloudSuite.

Be aware that in the cloud, all of your sites are defined in a single database, and only named user
licensing is allowed.

CloudSuite tenants
Each CloudSuite Industrial customer is set up with three tenants:

• Demo, which includes a CloudSuite Industrial application database that contains demo data and
multiple demo sites

• Training, which includes a CloudSuite Industrial application database that contains only initialized
data. The sites that you designed with the Infor Cloud team are included. This database is intended
for training.

• Production, which includes a CloudSuite Industrial application database that contains only initialized
data. The sites that you designed with the Infor Cloud team are included. This is the go-live database.

Each tenant has a separate application database, with separate logins and passwords. Nothing is
shared between the databases. If you set up data in your Production database and then want to copy
it to your Training database, or vice versa, you have two options:

• Use the To Excel option (on grid forms) to save data from a form to a spreadsheet and then import
it into the same form in the other tenant.
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• Ask the Infor Cloud team to refresh one tenant from the other tenant, which clears out the data in
the other tenant and replaces it with the data from the first tenant. To request this, create an incident
in Infor Xtreme.

Integration with other products in the CloudSuite
The CloudSuite Industrial ERP application uses different integration methods to communicate with
other products in the suite.

Draft Comments Could include technical architecture diagram here?.
Draft Comments Add section on web services after I get info from Suresh. Use CRM and Rhythm as
examples... for v10 ONLY!

Point to point integrations
Point to point integrations, for example with Infor Configure Price Quote (CPQ) or Factory Track, use
direct database connections that are set up by the Infor Cloud team. You might need to configure
additional parameters or master data in each of the applications to complete the integration. See the
appropriate integration guides.

BOD integrations
An outbound operation typically begins when a user performs an action in CloudSuite Industrial that
requires a data exchange with another ION-enabled application. A Business Object Document (BOD)
XML message is generated by CloudSuite Industrial and placed in an area designated as the CloudSuite
Industrial message outbox. At scheduled intervals, ION connects to the outbox and retrieves the BODs
from it.

In ION Desk, a connection point is set up for each application or site in the CloudSuite that can send
or receive BODs. (If you add applications later, the Infor Cloud team adds connection points for them,
as needed.) The connection point defines the information needed to connect to the application database.
It also holds a list of all the BOD documents that the application can send or receive.

You define document flows between the connection points to represent the business flows between
the applications. For example, the Infor Cloud team sets up a document flow between CloudSuite
Industrial and Infor Ming.le to pass BODs that contain user and role information. Use the Modeler in
ION Desk to define these document flows.

ION routes BODs according to the document flows between BOD-enabled applications. If a document
flow is defined fromCloudSuite Industrial to another application for a particular BOD, then at specified
intervals, ION places the outbound BOD from CloudSuite Industrial in the other application’s designated
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message inbox. Products are responsible for validating and incorporating the data in inbound BODs
according to their rules.

If a flow is defined from another application to CloudSuite Industrial, ION retrieves BODs from the
sending application’s message outbox and delivers them to CloudSuite Industrial’s message inbox for
processing. CloudSuite Industrial retrieves, validates, and processes the BODs.

Concepts and definitions specific to this configuration
You must understand the tenant, logical ID, accounting entity and location, and how they are defined
in this application. Together, these terms determine where inbound BOD information is processed, or
the outbound instance and location to which the BOD information should be associated.

Tenant ID
The tenant is a container for accounting entities and locations and is required in each BOD. The value
of the tenant must be the same in all of the products that exchange BODs. Data is not shared or
accessible between tenants.

The tenant ID is specified by the Infor Cloud team. You can view it in the Sites/Entities form. This
value should not be changed.

Infor provides you with three tenants. See About the CloudSuite on page 11.

See the information about using tenants in the Infor ION Desk User Guide - Cloud Edition.

Accounting entity
An accounting entity usually represents a legal or business entity that owns its general ledger. Every
transaction belongs to only one accounting entity. An accounting entity can also be defined as the
owner of certain master data among the enterprise. CloudSuite Industrial is the system of record for
accounting entities.

For CloudSuite Industrial, the site is used as the accounting entity.

Do not confuse this Infor definition of “accounting entity” with the CloudSuite Industrial definition of
“entity,” which is a type of site that is used only for financial consolidation.
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Location
A location is the physical location that is associated with data or transactions. The location can be, for
example, a warehouse, a manufacturing location, a project location, or an office. Locations are published
in the Location BOD. A location is required for all transactional BODs and is usually the location from
which a transaction or record is generated. CloudSuite Industrial is the system of record for locations.

Logical ID
The logical ID is a unique identifier used in the communication of data between the applications in the
tenant’s environment. Each instance of an application, for example, a site, is assigned one logical ID.
In ION, the logical ID is used to properly route BODs. Infor Ming.le uses the logical ID to determine
which application to start when you click a drillback.

This logical ID is defined in CloudSuite Industrial Sites/Entities form and should not be changed. For
cloud applications, the logical ID is defined by the Infor Cloud team and is retrieved automatically when
the application connection point is created in ION.

In Infor Ming.le, each application is assigned a logical ID. Infor Ming.le supports only one logical ID per
application.

For more information, see the CloudSuite Industrial online help.
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Chapter 3: Getting started

Ensure that all of these requirements are met before you start the configuration.

Determining your ERP application site names
If you are configuring a system with multiple sites, you must provide Infor with the names and descriptions
of all of the CloudSuite Industrial sites (also known as accounting entities) that you require.

Discuss your company’s site requirements with the Infor Cloud team. See the Infor CloudSuite Industrial
Multi-Site Planning Guide – Cloud Edition.

Be aware that in the cloud, all of your sites are defined in a single database, and only named user
licensing is allowed.

Determining the bootstrap administrator
You must designate one person as the bootstrap administrator, who will perform the initial setup of the
tenant for other users. Provide this person’s email address to Infor.

The bootstrap administrator, who could be an Infor consultant, a business partner, or an administrator
at your company, will receive an email from Infor with the initial URL to establish an Infor Ming.le user
name and login. This person also receives the Application Access email with the URLs to the
applications. The bootstrap administrator is the only person who can initially access the tenant.

Accessing your cloud environment (tenant)
1 After you register the bootstrap administrator’s email address, Infor sends an email to the bootstrap

administrator that asks to verify the Infor Ming.le account.

2 Click the link in the email.

3 3 Specify your first name, last name, title, email address, and a password.
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4 Click Create Account.
Note:  The link in the email expires in 48 hours. If you are past that time, please reset your password
with these steps:

a Remove everything after the Tenant ID in the original URL that was sent in the registration email.
For example, in https://mingle-portal.inforcloudsuite.com/ITSGENXXXA03/xxxxxxx/xxxxx,
ITSGENXXXA03 is the tenant ID, so you would delete everything after that.

b Copy the remaining URL and paste it into a web browser. A login dialog box should be displayed.
c Click the Forgot Password link.
d Infor sends a new Infor Ming.le Activation email to you.
e After Infor processes your account information, Infor sends you a second email with the actual

URL to sign in to your tenant.

Note:  At this point, Infor provisioning is not yet complete. Do not sign into your tenant until you
receive another “welcome” email from Infor that contains a list of useful URLs for your tenant.

Verifying access to your applications
After you sign in to the Infor Ming.le portal for the first time, ensure that you have system administrator
access to these applications in the cloud:

1 Under the User menu, verify that you can access the menu options Admin Settings and User
Management.

2 Under the App menu, verify that you can access Infor CloudSuite Industrial and Infor Operating
Service applications such as Infor Ming.le, ION Desk and Infor Document Management.
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3 Verify that you can access any optional applications that you have licensed, such as Infor Factory
Track or Infor Configure Price Quote.
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Chapter 4: Post provisioning steps

These are the initial steps that must be done after your tenant is provisioned by Infor.

If you engage Infor Consulting Services to perform post provisioning, they will perform the steps in this
chapter for you.

Note:  The Post Provisioning steps are often performed by the Bootstrap Administrator. At a minimum,
the person performing these steps must have IONDeskAdmin, IONDeskSecurityAdmin, and
IDM-Administrator roles assigned in Infor Ming.le, as well as the System Administrator group assigned
in CloudSuite Industrial. See Configuring user access to the ERP through Infor Ming.le on page 96 for
information about how to set up users and roles/groups.

Configuring BODs for ERP connection points
Connection points provide the information that ION uses to connect to an application’s message inbox
and outbox. At least one connection point is defined for each application instance that integrates to
ION. If you have a multi-site system, one connection point is defined for each CloudSuite Industrial
site.

Update the CloudSuite Industrial connection points to include the BODs that can be sent from, or
received into, CloudSuite Industrial:

1 In ION Desk, select Connect > Connection Points.

2 Select one of the predefined CloudSuite Industrial connection points. The Documents tab lists all
documents (BODs) that can be sent or received by this application instance for any integration. For
each document, the list must indicate whether the document can be sent, received, or both.

3 Click Add to set up a list of the documents that can be sent or received by this CloudSuite Industrial
connection point (site).
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ION uses this list to determine which BODs can be routed to or from the application when this
connection point is used in document flows. However, a BOD can be published by CloudSuite
Industrial to ION even if it is not listed in a connection point, as long as the BOD’s outbound setup
is configured properly on the Replication Document forms.

Note:  One of your CloudSuite Industrial connection points will already have some BODs listed,
because the  Cloud team set it up for the Infor Ming.le document flow.

Add all of the documents listed here, or just add the documents for the integrations with products
that you plan to use:

Used in integra-
tion with

Send from appli-
cation

Receive in appli-
cation

Document

CRMXProcess.BillToPartyMaster

CRMXProcess.ContactMaster

CRMXProcess.CustomerPartyMaster

ION (for alerts)XProcess.PulseAlert

CRMXProcess.Quote

EAMXProcess.Requisition

CRMXProcess.SalesOrder

Infor Ming.leXProcess.SecurityUserMaster

CRMXProcess.ShipToPartyMaster

CRMXSync.BillToPartyMaster

CRM, XMXSync.CodeDefinition

CRMXSync.ContactMaster

XMXSync.CurrencyExchangeRateMaster

CRMXSync.CustomerPartyMaster

CRMXSync.CustomerReturn

XMXSync.EmployeeTimesheet

XMXSync.ExpenseReport

CRMXSync.Invoice

CRMXSync.ItemMaster

CRMXSync.Location

CRMXSync.PayFromPartyMaster

CRMXSync.Person

XMXSync.Personnel

XMXSync.ProductionOrder
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Used in integra-
tion with

Send from appli-
cation

Receive in appli-
cation

Document

XMXSync.ProjectMaster

EAMXSync.PurchaseOrder

CRMXSync.Quote

CRMXSync.ReceivableTransaction

EAMXSync.ReceiveDelivery

XMXSync.RemittanceAdvice

CRMXSync.SalesOrder

Infor Ming.leXSync.SecurityRoleMaster

Infor Ming.leXSync.SecurityUserMaster

XMXSync.ServiceOrder

CRMXSync.Shipment

CRMXSync.ShipToPartyMaster

EAMXSync.SupplierPartyMaster

You might add other documents to the list later, for additional integrations.

4 Open each of the other predefined CloudSuite Industrial connection points. Add the BODs from
step 3.

Verifying BODs for the Infor Ming.le connection point
The Infor Cloud team has already set up the Infor Ming.le connection point. Verify that it contains the
correct documents.

1 In ION Desk, select Connect > Connection Points.

2 Find and select the Infor Ming.le connection point. In its Documents tab, verify that these documents
are listed:

Send from ApplicationReceive in ApplicationDocument

XProcess.SecurityUserMaster

XSync.SecurityRoleMaster

XSync.SecurityUserMaster
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Verifying the security document flow between the ERP and
Infor Ming.le
The Infor Cloud team has already set up a document flow between CloudSuite Industrial and Infor
Ming.le to pass user account and role (group) information. Verify that the flow is activated and that it
contains the correct connection points and documents.

Draft Comments If the Cloud team later starts to use Scott T's erp_mingle doc flow instead of the
MingleToCSI one, then change these steps to match. use the erp_mingle_document_lfow image and
change the "CSI" app box to "ERP."

1 In ION Desk, select Connect > Document Flows.

2 Find the document flow MingletoCSI and verify that it is marked as Active.

3 Select the document flow to open it.

Note: 

The CSI application box contains only one CloudSuite Industrial connection point (site). Because
the sites are all in one database, basic user data is shared between all sites. However, if you want
to ensure that updates to roles (groups) are also shared between all sites, you must set up a master
site and shared user tables in CloudSuite Industrial. (See the Infor CloudSuite Industrial Multi-Site
Planning Guide – Cloud Edition.) If you don’t want to use a master site and shared user tables, then
you must include all of the CloudSuite Industrial site connection points in this document flow

4 Select the document icon between Mingle1 and CSI and verify that it lists these documents:

• Sync.SecurityUserMaster

5 Select the document icon between CSI and Mingle_2 and verify that it lists these documents:

• Sync.SecurityRoleMaster
• Process.SecurityUserMaster

6 Make any needed corrections and save your changes.

Configuring EAM
If the CloudSuite includes EAM, use these post-provisioning steps to configure EAM for use with
CloudSuite Industrial.

Draft Comments This section needs to be tested with the latest EAM version in the cloud.
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Configuring the Databridge
Note:  The Infor Cloud team enables the Databridge partner, sets the connection information for the
shared ION I/O box, activates the partner record with partner code * (asterisk), and activates the
INFOR-ONRAMP partner. You must perform these additional configuration steps.
Draft Comments I combined steps from the CSI-EAM Integration Guide and the QA Central wiki EAM
Post-Provisioning section. If we keep this here, remove the steps from the integration guide.

1 In the Infor EAM application, select Administration > Databridge > Databridge Partners.

2 Select the INFOR-ONRAMP partner, and click the Subscriptions tab. Select Enabled for these
events:

• ADDREQUISTN/ProcessRequisition
• CHANGEREQUISTN/ProcessRequisition

For all other values, leave the current settings as-is or use the settings that are specified in the Infor
EAM Configuration Guide for Infor ION

Draft Comments Title is valid for current EAM version, but might change for next version. Verify
after that version is released.

3 Select Administration > Databridge > Databridge Setup.

4 On the Databridge Setup page, Options tab, Materials section, specify these values:

SettingField

YesEnable Add Requisition Outbound

AllEnable Change Requisition Outbound

NoEnable Cancel Requisition Outbound

For all other values, leave the current settings as-is or use the settings that are specified in the Infor
EAM Configuration Guide for Infor ION.
Draft Comments Title is valid for current EAM version, but might change for next version. Verify
after that version is released.

Mapping an EAM organization to the ERP site
Draft Comments This section is also currently in the CSI-CRM integration guide. If we keep it here,
remove it from there.

1 Select Administration > Security > Organizations.

2 On the Organization page, click the Record View tab and create a new organization that will be
linked to a CloudSuite Industrial site:
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3 Specify this information:

Accounting Entity
Set the Accounting Entity to the CloudSuite Industrial site/configuration name, for example, LA.

Currency
Ensure that the currency you set here matches the domestic currency of the CloudSuite Industrial
site.

4 Click More and select Enterprise Locations.

5 Specify a location for this organization on the Enterprise Locations tab. Link this Enterprise Location
to each of the listed BOD groups. Otherwise, the EAM organization is used as the location for BODs.

Later, when you add a store, you will specify this organization and enterprise location, and link it to
a CloudSuite Industrial warehouse.
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Mapping an EAM store to the ERP warehouse
1 Select Materials > Setup > Store.

2 Add a new store. Set the store name to a warehouse in the CloudSuite Industrial site, for example,
MAIN.

3 Specify this information:

Organization
Specify the organization that you added for the ERP site.

Enterprise Location
Specify the location that you added for the organization.

4 In the Bins tab, define bins for the store.
Draft Comments This step is not required in order for BODs to be sent and received, but it is needed
for testing and verification of Requisition BODs.

5 Optionally, use the Address tab to include an address for the store.
Draft Comments This step is not required in order for BODs to be sent and received, but it is needed
for testing and verification of Requisition BODs.

Draft Comments The QA Central wiki steps also indicate that you should add stock here. Bill Hinkle
(CSI QA) says that should be done in a different area of EAM. (See the section "Adding MRO parts")
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Adding MRO parts in EAM

Draft Comments This topic is not required in order for BODs to be sent and received, but it is needed
for testing and verification of Requisition BODs. This is a replacement of the QA Central wiki step where
they added parts as part of the EAM Store setup.

Add MRO parts, which cannot exist in CloudSuite Industrial.

1 Select Materials > Parts > Stock.

2 Add the part.

3 Assign the store, the default bin, which is needed for receiving, and prices for the part.

Adding suppliers

Draft Comments This topic is not required in order for BODs to be sent and received, but it is needed
for testing and verification of Requisition BODs.
You can either add suppliers manually in EAM, as described here, or you can perform an initial load
of vendor master data from CloudSuite Industrial through the Sync.SupplierPartyMaster BOD.

1 Optionally, select Materials > Setup > Suppliers
2 Specify the required information about each supplier.
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Adding a user for the organization
Draft Comments This topic is not required in order for BODs to be sent and received, but it is needed
for testing and verification of Requisition BODs.

Select Administration > Security > Users. Add at least one user and assign them to the organization
that you added.

Adding employees

Draft Comments This topic is not required in order for BODs to be sent and received, but it is needed
for testing and verification of Requisition BODs.

1 Select Work > Setup > Employees.

2 Add at least one employee. An employee is required in order to validate requisitions.

3 Associate the employee with a user record.

Verifying ISO units of measure and currency
Verify that you are using ISO standard currency codes and units of measure in both applications.

Draft Comments This topic is not required in order for BODs to be sent and received, but it is needed
for testing and verification of Requisition BODs.

If you are not using ISO standard U/M (materials) codes in EAM, select Materials > Setup > Units of
Measure to set up units of measure that match the ISO units of measure that are defined in CloudSuite
Industrial.

If you are not using ISO standard currencies in EAM, select Materials > Setup > Currencies to set
up currencies that match the ISO currency codes that are defined in CloudSuite Industrial.

Configuring CRM
Draft Comments This section needs to be tested with the latest CRM version in the cloud.
Draft Comments I have verified with CRM support that all of the steps in this section are currently
required to configure CRM in a ST environment. However, I think some/most of the topics are generic
to any CRM integration with Ming.le/Infor OS and could be removed from this guide when CRM is MT.
Use these post-provisioning steps to configure Infor CRM for use with CloudSuite Industrial.

Prerequisites

Ensure that you have this information before you perform the steps in this section:
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• Infor Ming.le URL with administrator credentials.
• CRM URL with administrator credentials. This information should be provided in an email from the

CRM cloud team.
• RDP details for the server in which the CRM application is deployed. This server is both the IOBOX

server and the web server for CRM. This information should be provided in an email from the CRM
cloud team.

• The IDP properties file, which is provided by the Infor Ming.le cloud support team.
• Infor Ming.le Homepages URL, which is provided by Infor Ming.le cloud support team.

Setting the Enterprise Location for CRM
Note:  If Java 1.8 JDK is not already installed on the CRM IOBOX server, install it before performing
these steps. Use the CRM IOBOX login credentials that were provided by Infor.

1 From the Infor Ming.le App Menu, select ION Desk.

2 Select Connect > Enterprise Locations.

3 Click + to add a location named CRM that will be used later for the CRM connection point.

4 Click OK.

This screen is displayed:

5 Click Download credentials to save the Access Key ID and Secret Access Key credentials for
this location.

You will need them in a later step.

6 Select Connect > Enterprise Locations again.

7 Click Download Enterprise Connector.
8 Download the .jar file to a local folder.

9 Use RDP to log in to the CRM IOBOX server, using the Infor-provided credentials.
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10 Copy the .jar file to the CRM IOBOX server.

11 Double-click the .jar file to install the ION Enterprise Connector and ION Grid.

12 When prompted during the installation process, use defaults where possible.

13 Specify Grid Connection Configuration values or accept the default values.

14 Specify the JDK Path or accept the default values.

15 Specify the Grid Database Name or accept the default values.
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16 On the Database Configuration step, specify the sa login and the password that was provided by
Infor.

17 On the Location Credentials and Tenant Mapping step, specify the Access Key ID and Secret
Access Key that were provided in step 5.
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18 When prompted, click Install and then Done.

Configuring Infor Ming.le for CRM
In the tenant that includes Infor Ming.le and CloudSuite Industrial, sign into Infor Ming.le as an
administrative user.

Use the steps in this section to add CRM as an application in Infor Ming.le.

Adding Infor CRM to Infor Ming.le

1 From the Infor Ming.le User Menu, select Admin Settings.

2 Click + ADD APPLICATION.

3 Specify this information about the application:

Application Type
Select Infor Non-Provisioned.

Application Name
Select the latest version of Infor CRM.

Display Name
If necessary, specify Infor CRM.
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4 Click Choose Icon and select the icon you want to represent the CRM application.

5 Select Use HTTPS.

6 Specify this information:

Host Name
Specify the URL that hosts the CRM application.

Port
Specify the port number. Leave this blank if there is no port number or if the port number is the
default, 443.

Context
Specify SlxClient/SetMingleContext.aspx.

Default Tenant
Specify your Infor Ming.le tenant ID.

7 Click Save and OK.

Adding Infor CRM as an authorized application

1 From the Infor Ming.le App Menu, select Infor ON API.
2 Select Authorized Apps.

3 Click + to add a new app.

4 Specify this information to define the app:

Name
Specify Infor CRM.

Type
Select Web.

Description
Specify a meaningful description.

Redirect URL
Specify https://Hostname/SlxClient, where Hostname is the domain name that holds the
CRM app, for example host.subdomain.infor.com.

Authorized Javascript Origins
Specify https://Hostname, where Hostname is the server that holds the CRM app, for example
host.subdomain.infor.com.

5 Click Save and OK.
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Configuring the CRM SDATA API

Draft Comments These steps are newer than the ones in the QA Central wiki, and should be tested
by ICS.

1 From the Infor Ming.le App Menu, select Infor ON API.
2 Select Available APIs.

3 Click + and select the Infor CRM template.

4 Under Deployment Information, click + to add a new deployment.

5 Specify this information:

Use HTTPS
Enable this option.

Ignore Certificate Errors
Disable this option.

Host Name
Specify the URL for the CRM host.

Port
Leave this field blank.

Context
Leave this field blank.

Default Tenant ID
Leave this field blank.

Use Mutual SSL
Disable this option.

Authentication Type
Select Basic.

User ID
Specify the user ID, for example, IonApi.Make a note of this ID, because you will need it when
you run the WebProvisionUI.exe tool.

Password
Specify a password. The password cannot be blank. Make a note of this password, because you
will need it when you run the WebProvisionUI.exe tool.

6 Click Save and OK.

Creating a service provider in Infor Ming.le

1 From the Infor Ming.le User Menu, select User Management.
2 Select Security Administration > Service Provider.
3 Click + to add a service provider.
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4 Specify this information:

Application Type
Select DEFAULT_WSFED.

Display Name
Specify Infor CRM.

Entity ID

Specify https://Hostname/WS-FED, where Hostname is the domain name that holds the CRM
app, for example host.subdomain.infor.com.

SSO Endpoint
Specify https://Hostname/SlxClient/default.aspx, where Hostname is the domain name
that holds the CRM app, for example host.subdomain.infor.com.

5 Click Save and OK.

Getting the fingerprint of SAML metadata

The fingerprint that you create here is used later.

1 From the Infor Ming.le User Menu, select User Management.
2 Select Security Administration > Service Provider.
3 Select the service provider you created earlier, and click the Edit icon next to it.

4 In the Identity Provider Information page, click View.

5 Copy the SAML metadata from the text box.
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6 Open a browser and go to www.samltool.com.

7 Click Online Tools.

8 Click X.509 Certificates.

9 From the left menu, select Calculate Fingerprint.
10 Paste the copied SAML metadata into the X.509 cert field.

11 In the Algorithm field, select sha1.

12 Click CALCULATE FINGERPRINT.

13 Copy the FingerPrint value to a text file and save it for a later step.

See Running the WebProvisionUI.exe tool on page 36.

Enabling the CRM Administrator to sign in to Infor Ming.le

1 In the CloudSuite Industrial tenant, sign into Infor Ming.le as an administrative user.

2 From the Infor Ming.le User Menu, select User Management.
3 Click the Details icon next to the user who you want to be the CRM administrator.

4 Click Additional Properties and copy the IFS Person ID value.

Infor CloudSuite Industrial Configuration Guide - Cloud Edition | 34DRAFT
 

Post provisioning steps



You can add administrative roles for this user in a later step.

5 In the Infor Ming.le App Menu (on the CloudSuite Industrial tenant) select Infor CRM and sign into
the CRM web client as an administrator, using the login and password that were provided by Infor.

6 In the Navigation menu, select ADMINISTRATION > Users.
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7 In the Users page, click ADMIN.

8 In the User – Administrator page, Federated Identity field, paste the Infor Ming.le IFS Person ID
that you copied in Step 4.

9 Save your changes.

Running the WebProvisionUI.exe tool
1 Request the Infor Ming.le IDP.properties file from Infor Ming.le support.

2 Sign in to the CRM server, using the credentials provided by Infor.

3 Place the IDP.properties file in the c:\Temp folder of the CRM server.
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4 Go to C:\Program Files (x86)\Saleslogix and run WebProvisionUI.exe. Specify this
information:

WebProvision Type
Specify Cloud.

Mingle Portal URL
Specify the URL used to access your Infor Ming.le portal.

CRM URL
Specify https://Hostname/SlxClient/default.aspx, where Hostname is the domain name
that holds the CRM app, for example host.subdomain.infor.com.

IDP Property File:
Specify C:\temp\IDP.Properties.

Deployment Path for SlxClient
Specify the drive and path to an IIS logical folder, for example: F:\inetpub\wwwroot\SlxClient

Deployment Path for SlxData:
Specify the drive and path to an IIS logical folder, for example: F:\inetpub\wwwroot\SlxData.

Default Tenant ID
Specify the Infor Ming.le tenant ID, as specified in the Infor Ming.le URL.

Certificate Thumb impression
Specify the thumbprint value that was calculated with the SAML tool.

See Getting the fingerprint of SAML metadata on page 33.

Mingle Logical ID
Specify the logical ID that was assigned to CRM when you added the application to Infor Ming.le.

Entity ID
Specify https://Hostname/WS-FED, where Hostname is the domain name that holds the CRM
app, for example host.subdomain.infor.com.

ION API Username
Specify the user ID that you provided when you configured the SDATA API, for example, IonAPI.

See Configuring the CRM SDATA API on page 32.

ION API Password
Specify the password that you provided when you configured the SDATA API.

Home Page URL
Specify the URL to access your Infor Ming.le Homepages, for example:
https://tenant-homepages.domain.infor.com.

This URL is provided by the Infor Ming.le Cloud team.

Mingle API Endpoint
Specify the endpoint, for example: https://Hostname/tenant/Mingle/SocialService.Svc.

The endpoint is retrieved from the Infor Ming.le ION API.
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5 Click Execute.

6 Restart IIS.

Adding a CRM connection point in ION
1 From the Infor Ming.le App Menu, select ION Desk.

2 Select Connect > Connection Points.

3 Click + and select Infor Application.

4 Specify this information for the connection point:

Name
Specify CRM.

Location
Specify CRM.
Note:  This must match the enterprise location that you set up earlier. See Setting the Enterprise
Location for CRM on page 27.

Logical ID Type

Specify crm.

5 In the Connection tab, specify this information:

Database Driver

Select SQL Server (Microsoft)

Host Name

Specify the Infor CRM hostname that was provided by Infor.

Port Number
Specify the port name that was provided by Infor.

Schema Name
Specify IOBOX.

User Name

Specify the Infor CRM administrative user that was provided by Infor.

Password

Specify the Infor CRM administrative user password that was provided by Infor.

6 Click Test to test your configuration.

7 Save your changes.
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Configuring BODs for the Infor CRM integration with Infor Ming.le
1 In ION Desk, select Connect > Connection Points
2 Select the CRM connection point.

3 In the CRM connection point's Documents tab, click + and add these documents for the CRM
integration with Infor Ming.le:

Send from
Application

Receive in Applica-
tion

Document

XProcess.SecurityUserMaster

XSync.SecurityRoleMaster

XSync.SecurityUserMaster

4 Additional BODs for integration with the ERP will be added later.
Draft Comments We discuss the CRM BODs used for integration with CSI in a separate section -
because the sections about configuring CRM for Ming.le might move out of this guide when CRM
is MT.

Creating the Infor Ming.le > CRM document flow
Draft Comments We discuss the CSI>CRM>CSI document flow in a separate section - because the
CRM-Ming.le sections might move out of this guide when CRM is MT.

1 In ION Desk, select Connect > Document Flows.

2 Click + and add a new document flow called crm_mingle with three application boxes.

3 In the properties pane for each of the application boxes, click Add and add the appropriate connection
points.

4 Click the document icon between CRM Sender and Mingle and include these documents:

• Sync SecurityRoleMaster
• Process SecurityUserMaster

5 Save the document flow.

6 Click the document icon between Mingle and CRM Receiver and include this document:

• Sync SecurityUserMaster
Draft Comments QA Central wiki also lists ProcessSecurityRoleMaster BOD but doesn’t show
it being selected. CRM support verified that ProcessSecurityRoleMaster is not supported. So I
removed it.

7 Save your changes and activate the document flow.
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Setting up Back Office integration between CRM and Infor Ming.le
1 In the Infor Ming.le App Menu (on the CloudSuite Industrial tenant) select Infor CRM and sign into

the CRM web client as an administrator, using the login and password that were provided by Infor.

2 In the Navigation menu, select INTEGRATION > Integrations.

3 Click Back Office Extension.

4 Select Enabled.

5 Click Save.

6 Click the Options tab.

7 In the Tenant row, Value column, specify your tenant ID.

8 In the Logical ID row, Value column, specify the CRM logical ID, for example,
lid://infor.crm.crm.

9 Save your changes.

10 Click the Back Office tab.
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11 In the Infor Ming.le row, Logical ID column, specify the Infor Ming.le IOBOX Logical ID.

12 Select Active.

13 Save your changes.

Installing and activating the ERP bundle for the CRM Back Office
1 Install the bundle on the CRM instance:

a Using RDP and the credentials and URL that were provided by Infor, log into the CRM IOBOX.
b Open the Saleslogix Administrator and log in using the provided credentials.
c Click Bundles and check the version of your CRM deployment, including all updates.
d Contact Infor Support and request the Infor CRM VFS BOE BOD Pack for your CRM version

that enables CloudSuite Industrial (SyteLine) Back Office integration. Save the file to a local drive
on the IOBOX.

e Open the Infor Application Architect and log in using the provided credentials.

Draft Comments How do we open this app? Are the credentials the same as for the IOBOX
login? CRM SME?

f Select Project Explorer.
g Right-click Bundle Model, select Bundle, and click Install.

h Select the downloaded Infor CRM VFS BOD BOD Pack and click Next.
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i In the Select Actions window, ensure that all components are selected.

j Click Finish.

2 In the Infor Ming.le App Menu (on the CloudSuite Industrial tenant) select Infor CRM and sign into
the CRM web client as an administrator, using the login and password that were provided by Infor.

3 From the Navigation menu, select INTEGRATION > Integrations.

4 Click Back Office Extension.

5 Click the Back Offices tab. Verify that you see Infor SyteLine on the list.

6 In the Infor SyteLine row, Logical ID column, specify the CloudSuite Industrial logical ID.
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7 Select Active for the row.

8 Save your changes.

9 If there are synchronization errors, you might need to ask the Infor Cloud team might need to restart
the CRM instance.

Testing the CRM to Infor Ming.le integration
In this step, you add roles to the CRM administrator user in Infor Ming.le, which verifies that the
integration between CRM and Infor Ming.le is working properly.

1 Sign into Infor Ming.le on the CloudSuite Industrial tenant as an administrative user.

2 From the User Menu, select User Management.
3 Click the Details icon next to the user of your choice.

4 In the Security Roles tab, click + to add a new role for that user.

5 Search for the CRM role and select all CRM-related roles.
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6 Save your changes.

7 In the App Menu, select Infor CRM.

8 Select ADMINISTRATION > Users.

9 Click the All Users tab.

10 Verify whether the user to whom you assigned CRM security roles is listed.

Configuring Birst
This section describes tasks you must perform to integrate Birst with Infor Ming.le for single sign-on.
The tasks must be performed before Birst users can be added.

Prerequisites:

• The customer-administrator who performs the tasks in this section must have the access rights
described here.

• In Birst, the user who performs SAML configuration must be a Birst account administrator.
• To configure service providers, the administrator must belong to the IFSApplicationAdmin role, and

be assigned to the Birst SAML Signing Certificate.

Configuring a placeholder service provider in Infor Ming.le
This task creates a placeholder service provider that will be deleted at the end of the overall procedure.
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During this procedure, you are instructed to upload the Birst Trusted Developer Certificate. Instructions
for doing this are in the Infor KB article 1988091 for these instructions. Infor recommends that you have
this article available before you perform this procedure.

1 As an administrator, log into Infor Ming.le for the tenant you want to configure.

2 Click the account name at the top-right corner of the page to expand the user menu.

3 Select User Management.
4 Select Security Administration > Service Provider.
5 From the Service Provider page, click the Add icon (+) to add the placeholder service provider.

6 For Application type, select Birst and specify a Display Name, for example, Placeholder
Configuration.

7 For Entity ID, specify a temporary name, for example, https://www.birst.com.

If you see an error message that this Entity ID already exists, you can use an alternate value or
change the value in some way to make it unique. The value of the placeholder service provider does
not matter but it must be unique from all other service providers.

8 For SSO Endpoint, select HTTP URL Redirect and specify a placeholder URL, such as
https://www.birst.com.

9 For SLO Endpoint, select HTTP URL Redirect and specify a placeholder URL, such as
https://www.birst.com.

10 For Birst SAML Signing Certificate, upload the Birst Trusted Developer Certificate.

See Infor KB article 1988091 for instructions to download the certificate.

11 Click Save.

12 You are redirected to the main Service Provider settings page in Infor Ming.le. From here navigate
to the configuration that you saved in the previous step and click Edit to open the configuration.

13 Click View.

14 On the page that pops up, click Export SAML Metadata and save the file as SAMLMetadata.xml.

Setting up the SAML configuration in Birst
1 As a Birst account administrator, log in to the Birst server that you want to configure.

2 Navigate to the account home page. Select Account Settings > SAML Configuration
3 Click the Add icon (+) to add a new configuration. Specify a name for the new configuration and

click the green checkmark to save it.

4 Locate the file SAMLMetadata.xml that was saved when you set up the placeholder service
provider. Use the file to specify this information:

a Copy the entityID field value and paste the URL into the Identity Provider Issuer field.
b Locate the <X509Certificate> section. Copy the certificate and paste it into the Certificate field

on the Birst configuration page. Copy everything between the <X509Certificate>
and</X509Certificate> delimiters.

c Find the <SingleLogoutService> for the HTTP-Redirect method in the XML file, and copy the
URL value from in the Location service field into the Identity Provider Single Logout URL field
in Birst.
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d Select the SP-Initiated checkbox.
e Find the <SingleSignOnService> for the HTTP-Redirect method in the SAMLMetadata xml file,

and copy the URL from the Location service field into the Identity Provider Single Sign-On
URL field in Birst. (You might have to scroll down the configuration page to see that field.)

5 Retain the default values for all other fields.

6 Click Save.

7 Make note of the value in the Service Provider Entity ID field in the saved page in Birst.

The unique Service Provider Entity ID that is required to register Birst in the Infor Ming.le Service
Provider configuration is generated when you save the Birst SAML configuration file. Copy this
unique value for use in a later step.

Also provided are the Birst SSO and SLO endpoint values, which are required for the Infor Ming.le
Service Provider configuration file.

8 Enable the newly created SAML configuration by toggling the slider in the SAML Configurations
panel.

Configuring the Birst service provider in Infor Ming.le
Locate the information from Birst that is required to set up the service provider in Infor Ming.le:

• The Entity ID, which is the Service Provider Entity ID field in Birst.
• The SSO Endpoint, in the form https://ServerName:443/SAMLSSO/Services.aspx. For example:

https://stage.sde.birst.com:443/SAMLSSO/Services.aspx
• ServerName is the Birst server you are using as an endpoint
• 443 is the port number that we will want to use for all https connections.

• The SLO Endpoint, which is the Service Provider Single Logout URL in Birst.
• The Birst SAML Signing Certificate, as noted in the prerequisites earlier.

To set up the service provider:

1 Launch a browser and sign in to Infor Ming.le as an administrator.

2 Click on the account name at the top right corner of the page to access the User Menu.

3 Select User Management.
4 Click the Users tile in the upper left portion of the screen to expand the navigation pane.

5 Expand Security Administration and select Service Provider.

6 From the Service Provider page, find the placeholder service provider that you set up in Infor Ming.le
earlier, for example, Placeholder configuration, and delete it.

7 Click + to add the new Birst application.

8 For Application type, specify Birst and specify the Entity ID, SSO Endpoint, SLO Endpoint and
the Birst SAML Signing Certificate information.

9 Save the configuration.
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Adding Birst as an application in Infor Ming.le
1 Launch a browser and sign to Infor Ming.le with an administrator account.

2 From the User Menu, select Admin Settings.

3 Click + ADD APPLICATION.

4 Select Infor Non-Provisioned as the application type.

5 Specify this information:

Application Name
Select the Birst application.

Display Name
Specify Birst.

Icon
Select the application icon and color.

Logical ID
The logical ID is displayed.

Use HTTPS
Select this field.

Hostname
Specify the URL of the Birst server, for example, sde.birst.com

To find the correct server, see URLs used either in your Birst SAML configuration (Service Provider
Single Logout URL), or your Infor Ming.le service provider configuration for Birst (SSO/SLO
Endpoints).

6 Leave the Port, Context, and Default Tenant fields empty.

7 Save the configuration.

8 In the Custom Parameters tab, specify the Identity Provider ID (idpid). You can find this ID using
either of these methods:

• In Birst, from the SAML Configurations page, it is the value of the birst.idpid= portion of the
SP-initiated Single Sign-On URL.

• In Ming.le, it is the GUID portion of the Entity ID for the Service Provider

9 Specify the Birst Space ID, which is available in the Modify Properties page of the Birst Admin
module for the space.

10 Save the information.

You can now access the Birst application from the Mingle App Menu. The Birst application gives users
direct access to the Birst dashboards in Infor Ming.le, as well as access the rest of the Birst app (for
example, Visualizer).
Note:  The access a user is given to the Birst application in Infor Ming.le is governed by the rights his
user has been granted within the Birst application.
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Adding Birst report widgets to an Infor Ming.le homepage (Visualizer
reports only)

Draft Comments I'm not sure if this applies to CSI with Birst ?
Prerequisites: Users will need to have Visualizer Access privileges in Birst to render Visualizer reports
in the Birst Report widget on an Infor Ming.le homepage.

1 Open your homepage in Infor Ming.le.

2 Click Edit.
3 Click Add Widget or +.

4 Select the Birst Report widget.

5 Click Add Widget.
6 Exit the configuration page.

7 Position or dimension this widget on your homepage.

8 Click Save.

9 Click… to configure the widget.

10 Specify the path to your Birst report in the Report field, for example, shared/My Report.

11 If multiple Birst applications are defined in Infor Ming.le, an Application field is displayed. Select
the application that shows the logical ID you set up when the Birst application was created.

Note:  It can take up to 30 minutes for your Birst application settings to be refreshed in your
homepage. If you do not see the appropriate logical ID displayed as an option, please allow time
for the applications to synchronize. Then try signing out and back in to finish your configuration.

If you encounter a configuration issue, you might need to refresh your web page to see the changes
take effect in the widget.

Using the web widget to add reports or dashboards to an Infor
Ming.le homepage
Prerequisites: Users must have the corresponding report privileges in Birst to render reports on an
Infor Ming.le homepage.

1 Open your homepage.

2 Click Edit.
3 Click Add Widget or +.

4 Select or search for the web widget.

5 Position or dimension this widget on your homepage.

6 Click Save.

7 Click … to configure the widget.

8 Specify your report URL in the URL field. The URL should be constructed as highlighted in the SSO
Parameters help page.
Draft Comments what help system is this in? Mingle or Birst?
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Birst URLs for use with the Infor Ming.le web widget

Embed a report:

https://stage.sde.birst.com/SAMLSSO/Services.aspx?birst.idpid=618441d2-
7e5e-4673-81df-32ad82d7b9fb&birst.spaceId=a8095f22-3c26-4a03-94bf-
8eb1cde3ff37&birst.module=visualizer&birst.embedded=true&embedded►
View=true&reportname=shared%2Fdonut.viz.dashlet

Embed a dashboard:

https://stage.sde.birst.com/SAMLSSO/Services.aspx?birst.idpid=12ed85ee-
2361-4745-88df-c6c85d08a62b&birst.spaceId=f0387f38-be16-441e-a7a9-
2d5c489cb198&birst.module=newDashboards&birst.dashboard=Collec►
tion&birst.page=Test&birst.embedded=true&hideHeader=true&hideSubHeader=true
 

Configuring Expense Management
Draft Comments This section needs to be tested with the latest XM version in the cloud.

Use these post-provisioning steps to configure Infor Expense Management for use with CloudSuite
Industrial.

Downloading and configuring the System Administration Tool (SAT)
Java version 1.8 or above (JDK 1.8) is a prerequisite for running this software.
Draft Comments This topic is already covered to some extent in the Infor Expense Management
SATClient Installer Guide, which is on Xtreme. Should we also include the steps here, for convenience?
The only CSI-specific information is in the last 2 steps.

Use these steps to download and configure the Infor XM SAT, which is used to configure information
such as users, groups, corporate data, and work items. For details about using SAT, see the Infor
Expense Management System Administration Tool User Guide.

1 Log into the Expense Management application with the admin (admin) account.

2 .Select Admin from the User menu.
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3 In the System Administration Tool tab, click Download Java SAT Installer.

4 Click Save File and save the sat.exe file to a local folder.

The sat.exe file is a self-extracting archive.

5 Go to the local folder and double-click on the sat.exe file. Specify the location to extract the files.

After extraction, these folders are created under the sat folder:

• bin: This folder contains the batch files sat.bat and startsat.bat. The sat.bat file
downloads the latest lib files required by SAT from the server, and the startsat.bat launches SAT.

• conf: This folder contains the sat.properties file, which contains configuration settings for
SAT.

• lib: The lib folder contains all the library files required by SAT. Initially this folder is blank.

6 Edit the sat.properties file in the conf subfolder. Verify that the server, servername and tenant
values are set correctly.

Infor CloudSuite Industrial Configuration Guide - Cloud Edition | 50DRAFT
 

Post provisioning steps



By default, the server and servername should be set to the Cloud URL for this instance of Infor XM.
Ensure that the tenant is correct for this customer.

7 In the bin subfolder, run sat.bat.

8 If the properties file was configured properly, you should see the batch commands run, and then a
login window is displayed.

9 Log into SAT using the admin (admin) account.

10 Select Tools > Configure ION.
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11 Select ION Enabled.

12 In the Accounting Entity Mapping tab, specify the CloudSuite Industrial site as the Accounting
Entity for the default company, and for any other companies that are defined.

13 Click Update.

Enabling ION in Expense Management
Draft Comments These are generic XM steps that do not reference CSI at all.

1 Log into the Infor Expense Management application again, using the admin (admin) account.

2 Select Admin from the User menu.

3 In the System Administration Tool tab, click Data: App Parameter.
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4 In the Name field, specify ion.enabled* and click Find.

5 When the ion_enabled parameter is displayed, set the value to true and save your changes.

6 Log out of the Expense Management application and log back in. Verify whether you can now see
the ION options in the System Administration Tool tab.
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Adding SSO through SAT

Draft Comments  These are generic EAM steps that do not reference CSI at all.

1 In the Infor Expense Management System Administration Tool tab, again click Data: App
Parameter.

2 Search for the sso.login.validatorClass parameter. Ensure that it contains the value
largesoft.db.SAMLPasswordValidator. Set the parameter's Status to Active and save
your changes.

Draft Comments screen shot too fuzzy?

3 Navigate to the Users screen and search for the user that you plan to use. In the Email field, specify
the SSO Login Email ID. This should be the administrator email address that you use to sign into
Infor Ming.le. A random password can be used, which you can change later.
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Draft Comments screen shot too fuzzy?

4 Save your changes.

Restart the server/tenant

Draft Comments  These are generic EAM steps that do not reference CSI at all. Also - can an
ICS/Business Partner really do this to a tenant in the MT cloud?

1 Go to Infor Xtreme, search for KB article 594391, and download the XMDBTOOL.

Use the file version number or most recent upload date to determine which zip file to download.

2 Go to the local folder where you downloaded the tool, and edit the xmdbtool.properties file.
Update the credentials and the Tenant ID in this file.

3 In the bin subfolder, double-click on Tenant_Restart.bat to run it.
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Configuring IPF licensing
For Infor Portals Foundation (IPF), the PortalPreLogin user was created by the Infor Cloud team.
Licensing for the user is performed during automation. Verify that this user exists and is set up as a
multi-session user:

1 In CloudSuite Industrial, open the Users form.

2 Verify that the PortalPreLogin user exists. Select that user.

3 Click User Modules.

4 In the User Modules form, assign the Portals license for the PortalPreLogin user.

5 Save your changes.

6 In the License Management form, select the Multi-Session Users tab.

7 Verify that the PortalPreLogin user is listed in the grid.

For more information about setting up the portals, see Infor CloudSuite Industrial Portal Administration
Guide - Cloud Edition.

Configuring CPQ
If the CloudSuite includes Infor Configure Price Quote, use these post-provisioning steps to configure
Infor CPQ for use with CloudSuite Industrial.

Draft Comments This section needs to be tested with the latest CPQ version in the cloud.

Installing Design Studio
Design Studio must be downloaded, installed and used locally for any Infor CPQ user who needs to
configure rulesets.

For now, install it for the bootstrap administrator.

1 From the Infor Ming.le App Menu, select CPQ Workbench.

2 On the workbench Home page, click Design Studio.
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If a warning message is displayed by your browser, click Keep. The DesignStudio.application
file is downloaded to the designated download area on your local drive.

3 Go to the download area and open the downloaded file.

4 Click Install.

This might take several minutes.

5 When the Service Connection dialog box is displayed, configure the connections:

a Click New. The Service Details dialog box is displayed

b To find the information you need, leave this dialog box open and return to the CPQ Workbench
app. Select Configurator API Keys from the menu. The information you need to supply is
provided here.
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c Copy and paste the values from the Tenant, User name, and User Api Key fields into the
Service Details dialog box.

d Click Test and verify that a Success message is displayed. Click OK.
e In the Service Connections dialog box, select a workspace and click OK.

Draft Comments  ? I just had one workspace option available (Active). Are there other choices?
Also, should we select the check box?

Importing sample ruleset data to Design Studio
Infor provides some sample ruleset data and content to help you understand how to use Design Studio
and CPQ Workbench. In this step, you import the ruleset data (including rulesets, matrices, and option
lists) from a ZIP file, extract the XMLs, and import them into Design Studio.
Draft Comments  This step could potentially be avoided if the CPQ team adds the demo data to the
database as an automated step during provisioning.

1 Go to http://gde.infor.com/SitePages/default.aspx and select Demo Environment Supporting
Information > Demo Environment Resources > Product Demo Information > Infor CloudSuite
Industrial (CSI) > Active Version(s) > Infor Hosted CloudSuite > CPQ-CPQEQ > ..
Draft Comments Can/should we put this in a more accessible place?

2 Click 2a-XMLs to Import to Design Studio to download the ZIP file to your local download area.
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3 In your local download area, extract the XML files from the ZIP file.

4 If Design Studio is closed on your local computer, open it and connect to the environment you
configured in Installing Design Studio on page 56.

5 Right-click in the white space under the Rulesets tab and select Import.

6 Browse to the local download folder that contains the XMLs. Select one XML and click Open. When
a success message is displayed, click OK. Repeat this step for each XML in the folder.

Note:  The XML files include sample Rulesets, Include Rulesets, Matrices, and Option Lists. You
can import all of these under the Rulesets tab, and they will be displayed under the appropriate
tab. You can click in the different tabs to see the imported information.

If you mistakenly import the same XML twice, it creates a second copy and does not cause problems.

Importing sample content to CPQ Workbench
Infor provides some sample ruleset data and content to help you understand how to use Design Studio
and CPQ Workbench. In this step, you import the sample content from a ZIP file, extract XMLs, and
import them into CPQ Workbench.
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Draft Comments  This step could potentially be avoided if the CPQ team adds the demo data to the
database as an automated step during provisioning.

Note: 
Before you start this step, you must import all of the sample XML ruleset data. See Importing sample
ruleset data to Design Studio on page 58.

1 Go to http://gde.infor.com/SitePages/default.aspx and select Demo Environment Supporting
Information > Demo Environment Resources > Product Demo Information > Infor CloudSuite
Industrial (CSI) > Active Version(s) > Infor Hosted CloudSuite > CPQ-CPQEQ > ..
Draft Comments Can/should we put this in a more accessible place?

2 Click 2b-Content to Upload to Content Manager to download the ZIP file to your local download
area.

3 In your local download area, extract the XML files from the ZIP file.

A folder named Content to Upload to Content Manager is created, with subfolders that contain the
sample images, Infolinks, and Flex2D files to upload.

4 From the Infor Ming.le App Menu, select CPQ Workbench.

5 In CPQ Workbench, select Configurator Content Manager.

6 Expand the Flex2D folder. If the Models and Templates subfolders do not exist, click + and add
them.
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7 Under both the Models and Templates folders, click + and add a subfolder called WD2.

8 Select the Models/WD2 folder, click the Upload icon, and then click in the Drop files arearea.

9 In the dialog box, browse to your download area and find the Content to Upload to Content
Manager folder where you extracted the content. In that folder, browse to the Flex2D\Models\WD2
folder, and open that folder. Select all of the files in that folder and click Open.
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After the files are uploaded, they are listed with

checkmarks..

10 In the Configurator Content Manager page, select the Templates\WD2 folder and upload the
content from the Content to Upload to Content Manager\Flex2D\Models\WD2 folder.

11 In the Configurator Content Manager page, you can now open the WD2 subfolders and see content
in each of them.

12 Under both the Images and Infolinks folders, click + and add these subfolders: BC, FKL and
WD.

13 In the extracted local folders, you will notice that in Content to Upload to Content Manag
er\Images\BC, there are additional subfolders. Create matching subfolders in the Configurator
Content Manager under the Images\BC folder.

14 Select each of these new subfolders in the Configurator Content Manager and import the content
from the matching subfolders in the local download area.
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15 Follow a similar procedure to import the remaining subfolders in the Images area.

16 Follow a similar procedure to import the subfolders in the Infolinks area.

After all of the sample content has been uploaded to the Configurator Content Manager, then when
the rules are run, images and Flex2D graphics are displayed.

Verifying and updating Configuration Parameters in CloudSuite
Industrial
Use these steps to verify that the integration with CPQ was successful.
Draft Comments  Brief overview of task

Draft Comments  Introduction to the steps

1 From the Infor Ming.le App Menu, select Infor CloudSuite.

2 In CloudSuite Industrial, open the Inventory Parameters form.

3 In the Product Configuration tab, click Initialize Configuration and verify that a success message
is displayed, indicating that a connection between CloudSuite Industrial and Infor CPQ has been
established.

4 Verify that the Configurator Service fields are all populated, and the Application ID and Namespace
under Document Automation are populated. (The default ruleset can be specified later.)

5 If you will be using Infor CPQ with the CloudSuite Industrial portals, ensure that the Configurator
Web Service URL is populated. If not, contact the Infor Cloud team (Infor CPQ) for the correct
value.
Draft Comments verify whether this information is provided by an automated provisioning step?

6 Specify this additional information for the CloudSuite Industrial portals, if needed:

Default Profile
Specify Default.

Enable Configurator for Portal
Specify whether to use the Portal Configurator UI or the CPQ Configurator UI.

Configuring Factory Track
After provisioning, the Site Parameters form includes ERP-specific connection information. During
post-provisioning, perform these tasks to ensure that the CloudSuite Industrial data is available to
Factory Track:

1 In Factory Track, open the Site Parameters form.

Infor CloudSuite Industrial Configuration Guide - Cloud Edition | 63DRAFT
 

Post provisioning steps



2 In the CloudSuite Industrial Communication tab, click Test Communications to verify that the
applications are communicating.

3 Click Generate.

4 Open the Jobs List form, and make a note of how many jobs are currently listed there, for later
reference.

5 Open the Load Orders from ERP form. Specify the CloudSuite Industrial site from which you want
to import, and the number of days prior and into the future to import data. Select the types of orders
to import, and click Process.

6 Reopen the Jobs List form and filter to show all jobs. If there are more jobs than were shown in
step 4, then Factory Track is communicating with the ERP site and is pulling data properly.

Note:  Optionally, you can set up a background task to run the import from the ERP on a regular basis.
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Configuring IDM
The Infor Cloud team imported the CloudSuite Industrial document types, Business Context Model,
and Access Control List (ACL) into the Infor Document Management (IDM) application as part of the
provisioning process.

About the IDM integration
Infor Document Management (IDM) and CloudSuite Industrial are integrated through these methods:

• ION API (REST-enabled)
• Context Business Messages
• Draft Comments add this (BOD nouns and Capturedocument) when IDM Capture is supported.

BOD nouns

The CaptureDocument BOD is an outbound BOD that is sent by IDM when capturing different types
of documents, for example, scanning documents.

CloudSuite Industrial delivers application-specific document models for use with IDM.

Some reports and documents that are generated in CloudSuite Industrial can be automatically sent to
Infor Document Management (IDM) for storage. You can then view the documents in IDM or in the
context of a CloudSuite Industrial form, through the Related Information context app. You can search
the IDM repository for documents by filename, originating user, and date. You can also search for
some documents using other meaningful attributes such as purchase order number or invoice number,
if those attributes are set up for the document type in IDM.

This integration uses CloudSuite Industrial document workflows, APIs that transmit the data from
CloudSuite Industrial to IDM, and a business context model, document types, and an access control
list that are imported into IDM.

Initially, only CloudSuite Industrial invoice and purchase order reports have predefined document
workflows. You can customize the integration to include additional document workflows, or to modify
the existing workflows.

These attribute values are assigned as metadata that accompanies the documents, and can be used
for filtering within IDM:

• For an invoice, the metadata includes the invoice number, the number of the customer being invoiced,
and the number of the customer order associated with the invoice.

• For a purchase order, the metadata includes the PO number and the number of the vendor to whom
the PO is assigned.

The API integration has this high-level flow:
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In the case of failure, a notification is sent to the email address that is assigned on the CloudSuite
Industrial Users form to the user who originated the report. The PDF file that could not be stored in
IDM is included as an attachment in the email.

CloudSuite Industrial also supports a BOD-based integration with IDM Capture (using Ephesoft), as
shown in this diagram:

Currently, the BOD-based integration is only used for supplier invoices. When you receive an invoice
from a supplier, it is either a paper document or an electronic file. You can perform an OCR scan of
the paper document into IDM Capture, or you can load the electronic file into IDM Capture.

In IDM Capture, the parts of the invoice are segmented into fields. IDM Capture sends the invoice
information in a Sync CaptureDocument BOD to IDM, where the invoice information is validated and
the invoice document is stored. The invoice information is then sent through another Sync
CaptureDocument BOD to CloudSuite Industrial, where vouchering against the invoice is performed
automatically or through the Voucher Builder. The quantities on the vendor invoice must already have
been received in CloudSuite Industrial; otherwise, the invoice is rejected. Also, if the vendor invoice
quantity is greater than the PO line received quantity, the invoice is rejected.

You can view the supplier invoice documents in IDM.
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You can also find the supplier invoice document in the Related Information context app when associated
CloudSuite Industrial forms are displayed. For example, when you view the voucher record in the A/P
Posted Transactions Detail form, you can see the associated supplier invoice document in the Related
Information widget.

IDM-related forms in the ERP

The IDM connection information is preset on the External App Parameters form. You should not
change these settings.

The API call to IDM impersonates the user who is actually creating the documents in CloudSuite
Industriall. CloudSuite Industrial users are matched to IDM users through the Infor Ming.le (IFS) GUID
value, which is shown in the Workstation/Domain ID field of the Users form.

Look at the IDM Document Workflows form to understand which document workflows are predefined.
The predefined workflows are activated as part of the Post Provisioning steps. However, you can
deactivate any workflows that you do not plan to use.

Later, you could use the advanced features on this form, along with the Application Event System, to
customize the integration. See the online help for assistance with the advanced fields.

Document types and their assigned roles

This table shows the predefined CloudSuite Industrial document types, the ACL that is used with each
document type, and the IFS roles that are assigned to each document type. The IFS roles are
synchronized with CloudSuite Industrial and IDM through BODs. See User and role BOD usage on
page 137.

If you are not using the standard CloudSuite Industrial groups, you will need to modify this list in IDM.

Access to read, update or delete the documents in IDM is only allowed for users who belong to at least
one of these roles (groups). You can modify the ACL list in IDM.

PermissionsSecurity rolesACL nameDocument type

Read, Update, Create,
CheckIn, CheckOut

Accounts Payable, Pur-
chase Reqs, Purchas-
ing, Purchasing Costs

InforPurchaseOrderCS_PurchaseOrder

Read, Update, Create,
CheckIn, CheckOut

Accounts Receivable,
Field Service, Order En-
try, Order Entry Invoic-
ing Reprint, Projects,
Service

InforSalesInvoiceCS_SalesInvoice

Read, Update, Create,
CheckIn, CheckOut

Accounts Receivable,
Field Service, Service

InforSalesInvoiceCS_ServiceInvoice

Read, Update, Create,
CheckIn, CheckOut

Accounts PayableSyteLineVoucherCS_SupplierInvoice
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Document types and their assigned attributes

This table shows the predefined CloudSuite Industrial document types in IDM, the entity name associated
with the document type, and the attributes that can be used to search and filter within each document
type.

Because a service invoice is a type of sales invoice, it uses the InforSalesInvoice entity name. However,
the context is slightly different: service invoices have the SRO number attribute, while sales invoices
have the customer order number attribute.

If you add attributes to a document type, be aware that the attribute ID in IDM must exactly match the
IDO property name that is sent from CloudSuite Industrial. This is true for CS_PurchaseOrder,
CS_SalesInvoice, and CS_ServiceInvoice. However, for CS_SupplierInvoice, the attribute ID and IDO
property name need not match. If the optional attributes are included for a supplier invoice, CloudSuite
Industrial can use them.

Additional attribute IDs *Entity nameDocument type

PoNum, VendNumInforPurchaseOrderCS_PurchaseOrder

InvNum, CustNum, CoNumInforSalesInvoiceCS_SalesInvoice

CustNum, SroNumInforSalesInvoiceCS_ServiceInvoice

PoNumber, VendorNumber, In
voiceNumber (Optional: Invoice
Date, VendorOrder, Freight, Mis
cCharges)

InforSalesInvoiceCS_SupplierInvoice

* These attributes are common to all document types, so are not listed in the table: Description,
AccountingEntity, BOD Reference Accounting Entity, BOD Reference Document ID, BOD Reference
Noun, BOD Reference Revision ID, EntityType, and Location.

Other document management options

In addition to the features of the IDM application, there are document management features built into
CloudSuite Industrial. The CloudSuite Industrial built-in feature can associate documents with IDO
rows and IDOs. There might be times when you need to use these features instead of, or in combination
with, the IDM features.

See the CloudSuite Industrial help topic about working with document (file) attachments.

Tasks performed by the Infor Cloud team
The Infor Cloud team performed these tasks related to IDM:

• In CloudSuite Industrial, the Infor Cloud team set up the IDM connection information on the External
App Parameters form
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• In IDM, the team imported these CloudSuite Industrial-specific objects:
• The predefined document types CS_SalesInvoice, CS_ServiceInvoice, CS_PurchaseOrder, and

CS_SupplierInvoice
• A predefined Business Context Model (BCM) for each document type. The BCM is used to map

the document type to the entity type. It also maps the web container ID variables that are sent
in JSON messages from the CloudSuite Industrial forms. For example, for the CS_SalesOrder
document type, the CustNum value is always stored in {id1}, even if the form's JSON message
sent CustNum as the second or third variable. See the information about business context models
in the Infor Document ManagementAdministration Guide - Cloud Edition.

• An Access Control List (ACL) that defines the IFS security roles that can access each document
type.

Disabling the Document Type filter
To ensure that all of the document types will be visible in IDM and the Related Information app:

1 In the Infor Document Management application, click the Administration menu.

2 Click Configuration.

3 Select Document Type Filter and disable the filter.

4 Save your changes.

Activating the Related information context app
You must activate the Related information context app, so that it is displayed next to the CloudSuite
Industrial form. This app shows documents from IDM that are related to the current CloudSuite Industrial
record.

1 From the User Menu, select Admin Settings.
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2 In the Manage Context/Utility Apps tab, select Related Information.

3 In the Permissions tab for that app, select Grant access to all users and click Save.

4 In the Applications tab, set Document Management and Infor CloudSuite to be Enabled for
the Related information app.
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5 Click Save. In order to see the changes, you might need to sign out of the application and Infor
Ming.le. Close your browser and reopen it.

Verifying the IDM connection in the ERP
1 Open the CloudSuite Industrial app.

2 Select Form > Open and open the External App Parameters form. The connection information
should already be entered by the Infor Cloud team.

3 Click Verify. A green check mark is displayed next to the button if the connection was successful.

If the connection was not successful, a red X is displayed, and you should contact your Infor
representative.

Activating the IDM workflows in the ERP
When CloudSuite Industrial users generate a document that has an active workflow, the document is
sent to IDM. To activate the workflows:

1 In CloudSuite Industrial, open the IDM Document Workflows form.

2 Select Active for each predefined workflow if you want that type of document to be sent to IDM.
Your choices should be based on business decisions for the company.
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3 Save your changes.

Later, you could use the advanced features on this form, along with the Application Event System, to
customize the integration. See the online help for assistance with the advanced fields.

Verifying the configuration for workflows
After the configuration is set up in all applications, use these steps to generate a document in CloudSuite
Industrial and verify that the document is available, with the appropriate attributes, in IDM.

Currently the invoice and purchase order reports are predefined for this process, but we will just verify
the PO report.

1 In CloudSuite Industrial, open the Purchase Order Report form and print a purchase order.

2 Open the IDM Workflow Logs form and verify that a record exists for the new PO.

See the online help for an explanation of the fields on this form.

3 In the Infor Document Management application, verify that you can find and preview the document
using these options:

Document Type
Specify CS_PurchaseOrder.

Select Attribute
Verify that these attributes are in the list: PO Number and Vendor Number. Select PO Number.

Operation
Select Like.

Value
Specify the PO number. Use the % wildcard character to allow for leading and trailing spaces.

4 In CloudSuite Industrial, open the Vendors form.

5 Select the vendor associated with the purchase order number that you printed.

In the Related Information context app, the document should be displayed automatically. The default
entity type is All, which displays any document that matches the current record.
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6 Verify that you can preview the purchase order.

Troubleshooting:

• If a document cannot be inserted into IDM, an error message is sent to the user who generated the
document in CloudSuite Industrial. The user can then attempt to manually attach the document into
IDM, using the appropriate document type and attributes. However, if the error occurred because
the user does not have the appropriate role assigned in IDM, then the user cannot insert the document
into IDM. In that case, you must ensure that the ACL in IDM has the appropriate roles assigned to
the document type, and that the user is a member of one of those roles in CloudSuite Industrial and
Infor Ming.le (IFS).

• If a user prints a range of purchase orders or invoices, the documents will be generated either in
one PDF or in individual PDFs, depending on how the user's Document Profile is set up in
CloudSuite Industrial. If all of the documents are in a single PDF, the PDF is attached in IDM to the
first record in the range. We recommend that users set their Document Profiles to generate individual
PDFs for a range of documents.

Configuring IDM Capture with Infor OS
Infor Document Management Capture enables you to convert a high volume of unstructured document
data from multiple formats into structured information by using machine learning and analytics. The
automated conversion of document data categorizes each document by type and captures and stores
relevant data for each document, providing greater efficiency, productivity, and a more detailed analysis
of your business processes within the ERP.

When you purchase IDM Capture as part of your CloudSuite, you receive an email with important
information about accessing Ephesoft from your tenant. Use this information to configure Ephesoft in
Infor Ming.le.
Draft Comments Who will actually do this – Steve Leitz’s Services team or Business Partner? Setting
Cloud paragraph below to WIP temporarily, per Suresh.

Information received from Ephesoft

When you purchase Infor Document Management Capture as part of your cloud package, Infor notifies
the Ephesoft Cloud Ops team about your environment and products. Ephesoft sends an email to Infor
with the following prerequisite information and files, which are specific to your environment. Infor
forwards this email to you. You will use the information and files when you add and configure Infor
Document Management Capture in Infor Ming.le. You must do this for every tenant.

ExamplePrerequisite

https://server/dcma/home.htmlIDM Capture application URL

Link providedSingle Sign On endpoint for IDM Capture

Link providedSingle Logout endpoint for IDM Capture

ephesoft.abcEphesoft certificate file attached to the email
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1 Create a folder on your local drive called ephesoft_files. Download the certificate file to the local
folder and change the filetype from .abc to .cer. You use this file later..

2 Save the email so you can refer to it later in this guide.

Configuration of IDM Capture in Infor Ming.le

If you plan to use IDM capture with CloudSuite Industrial as part of an IDM solution, follow the steps
in this section to add the app, roles, service provider, and ION API file in Infor Ming.le.

Note: You must have Infor-SystemAdministrator access in order to perform these steps.

Adding security roles (if necessary)

1 From the User Menu, select User Management.

2 Click the menu in the upper left corner.

3 Select Configure > Master Data Types > Security Roles.
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4 Check for these security roles. If not already present, add them. Click + to add a new security role.

• EPHESOFT-USER
• EPHESOFT-Administrator
• EPHESOFT-SystemAdministrator

5 Fill in this information for each security role:

DescriptionName

Access to activities under Operator (view my
batches, open next batch, scan new documents,
and upload new documents)

EPHESOFT-User

Same security as Ephesoft User with additional
access to Administrator activities (batch class
management, batch instance management,
folder management, and reports)

EPHESOFT-Administrator

Same security as Ephesoft Administrator with
additional access to System Configuration (where
an administrator can add and remove access on
roles)

EPHESOFT-SystemAdministrator

6 Click Save after you add each role.

Adding the Capture application in Infor Ming.le

1 From the User Menu, select Admin Settings.
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2 Click + ADD APPLICATION.

3 Specify this information:

Application Type

Select Non-Infor.

Display Name

Specify Capture.

Application URL
This URL is provided in the email from the Ephesoft Cloud Ops team. Verify that this URL follows
the format in Information received from Ephesoft on page 73.

Icon

Choose the IDM capture icon in any color.

4 Click Save.

5 In the Permissions tab, click Add New Users and/or IFS Security Roles.

6 Search for and select the check boxes for these security roles:

• EPHESOFT-User
• EPHESOFT-Administrator
• EPHESOFT-SystemAdministrator
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7 Click Done and then Save.

Adding Infor Document Management Capture as a service provider in Infor
Ming.le

1 From the User Menu, select User Management.
2 Click the Users menu in the upper left corner.

3 Select Security Administration Service Provider.

4 Click + to add a new provider.

Note:  If this button is not enabled, contact Infor CloudOps.
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5 Specify this information:

Application Type
Select DEFAULT_SAML.

Federation Protocol
SAML is selected automatically.

Display Name
Specify IDM Capture.

Entity ID
Specify the URN in this format:

Urn:Ephesoft:customer-prefix:portal

Create this URN based on the suggested format, and send it to the Ephesoft Cloud Ops team. See
Sending information to Ephesoft Cloud Ops on page 81.

SSO Endpoint
Select HTTP Post and specify the Single Sign On endpoint, which is supplied by the Ephesoft
Cloud Ops team. See Information received from Ephesoft on page 73

SLO Endpoint
Select HTTP POST and specify the Single Logout endpoint, which is supplied by the Ephesoft Cloud
Ops team.See Information received from Ephesoft on page 73

Signing Certificate

Click the browse icon and browse to the ephesoft_files folder where you stored the Ephesoft
certificate file. Select the ephesoft.cer certificate file.

6 Click Save and then edit the IDM Capture provider that you just added.

7 Click View.
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8 In the dialog box, click Export SAML Metadata. Save the IDP file
(ServiceProviderSAMLMetadata_date.xml) to the ephesoft_files folder. You will send this file
to Ephesoft later. See Sending information to Ephesoft Cloud Ops on page 81.

9 Click Cancel to close the dialog box.

10 Click Save at the top of the IDM Capture service provider dialog box .

Setting up the ION API file in Infor Ming.le

To create the ION API file, you must create a service user, register the user in IFS, and create the ION
API file.

Creating the service user
1 From the User Menu, select User Management.
2 Click + to add a new user.

3 Specify this information:

First Name
Specify IDM-CaptureUser.

Last Name
Specify Capture.

Email Address
Specify the email address of your administrator

4 Click Save.

Registering the user

1 From the User Menu, select User Management.
2 On the right side, search for the user IDM-CaptureUser that you made earlier.

3 Click the Details icon for that user.

4 On the Security Roles tab, click + to add a role.

5 Search for and add these security roles:

• IDM-AdvancedUser
• Infor-SuiteUser
• Mingle-Enterprise

6 Click Add & Close.

Creating the ION API file
1 Open Infor ION API in the Infor Ming.le portal
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2 Click the Available APIsmenu. Ensure that Infor Document Management is among the options. If
not, Infor CloudOps must register IDM with ION API via CSP. Contact Infor CloudOps to do this.
Then, continue with these steps.

3 Select Authorized Apps.

4 Click + to add a new application. Specify this information:

Name
Specify IDM-Capture.

Type
Specify Backend Service. If you do not see this option, see Enabling a back-end service on
page 81.

Description
Specify IDM Capture.

5 Use the default values for the rest of the fields and click Save.

6 Reopen the newly added application.

7 Click Download Credentials.
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8 Under User Name, search for and select IDM-CaptureUser. The user name must be blue to be
a valid user name

9 Click Download.

Note:  You can download this file only once. Do not perform this step again.

10 Save the file to your ephesoft_files folder. You will need it when verifying the integration.

Sending information to Ephesoft Cloud Ops

Send an email to Cloud.Operations@Ephesoft.com. Set the subject of your email as the Entity ID as
shown below. Make sure that your email has the following files and information:

DescriptionOutput

This file was generated in Adding Infor Document
Management Capture as a service provider in Infor
Ming.le on page 77.

IDP Metadata

This URN was specified in Adding Infor Document
Management Capture as a service provider in Infor
Ming.le on page 77.

Entity ID

Ephesoft Cloud Ops will complete the setup on their end and send you a confirmation email when you
can start testing the application in your environment.

Enabling a back-end service

1 In the User Menu, select User Management.
2 Select Security Administration > General Settings and click Manage Features.

3 Select Enable Service Accounts.

4 Sign out and sign back in.

5 Add the IDM-Capture authorized app again. The Backend Service should now be available.
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Verifying the configuration for BODs
Draft Comments When IDM Capture is supported, get the latest steps from ICS or from the IDM
Capture Config Guide.

Use these steps to load a supplier invoice document, generate a related voucher, and verify that the
document is available, with the appropriate attributes, in IDM.

1 In CloudSuite Industrial, use the Purchase Order Receiving form to receive the purchase order that
is associated with the supplier invoice.

2 In IDM Capture (using Ephesoft), either scan the paper document or load the electronic file.

3 In IDM, verify that the document exists and is tied to the CS_SupplierInvoice document type.

4 In CloudSuite Industrial, open the A/P Posted Transactions Detail form and verify that a voucher
has been created for the supplier invoice.

5 Select the voucher associated with the supplier invoice number that you printed.

In the Related Information context app, the document should be displayed automatically. The default
entity type is All, which displays any document that matches the current record.

6 Use the Related Information context app to search for the related supplier invoice document.

Configuring the OCR BOD integration
Draft Comments When IDM Capture is supported, get the latest steps from ICS. Rachel Paek provided
a sample document from M3 that tells what each thing is the batch class does. We should create a
similar doc and refer to it here (or include it in this guide as an appendix?). Also, we will need to have
a sample batch class file for Vendor Invoices that can be imported into Ephesoft. Check what CSD doc
team is doing.
Note:  These steps might require assistance from an Infor consultant or Ephesoft support. See the
Ephesoft wiki pages (http://www.wiki.ephesoft.com) for more information about batch class configuration.

1 In IDM Capture (using Ephesoft), create a Batch Class that corresponds to the supplier invoice
documents that you plan to scan. In the Batch Class index fields, describe the fields from the invoice
that should be captured, for both the header and line sections of the invoice.

A sample of each supplier invoice is needed to ensure that the field names, positions and formats
are set up so that capturing can occur.

See the Ephesoft wiki pages for more information.
Draft Comments Verify where information is provided? . Might be in our appendix?

2 When you set up the integration of IDM Capture with IDM, map these Batch Class index fields for
each supplier invoice to the XML paths in the Sync CaptureDocument BOD.

Note:  Mapped fields must be spelled exactly as they will be validated in CloudSuite Industrial. The
invoice amount is not validated.

In order for CloudSuite Industrial to correctly read the Sync CaptureDocument BOD, these
CaptureDocument/DocumentField/Name values must be used:

• VendorNumber: The CloudSuite Industrial vendor number. This field must exist in the file. The
vendor number is validated when the inbound BOD is processed. Leading spaces can be omitted,
because they are added during processing.
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Note:  Some supplier invoices do not include the vendor number. In that case, you must manually
add the vendor number here.

• InvoiceNumber: The vendor's invoice number. This value can be omitted, but if it exists, it is used
as a reference number on the voucher transaction.

• InvoiceDate: The date when the vendor invoiced the purchase order. This field is used if it exists.
Otherwise, the invoice date is set to the current date.

• PONumber: The CloudSuite Industrial purchase order number. This field is used if it exists.
Otherwise, the purchase order number is found by using the VendorOrder number.

• VendorOrder: The vendor's purchase order number. If this field exists and the PONumber is not
provided, this field is used to find the PO. If both fields exist, this field is not used.

• Freight: The freight charges for the order. If no value is provided, the value is set to zero.
• MiscCharges: The miscellaneous charges for the order. If no value is provided, the value is set

to zero.

In order for line level information to be correctly read, these
CaptureDocument/DocumentTable/Row/Column/Name values must be used:

• Item: The CloudSuite Industrial item from the purchase order that is being vouchered. This field
is used if it exists. Otherwise, the item number is found by using the VendorItem number.

• Quantity: The quantity of the item that is being vouchered. This value must be provided. The
value is expected to be in the same unit of measure that was used for the item on the PO line.

• UnitPrice: The unit price of the item. If this value exists, it is used. Otherwise, the unit price from
the PO line is used.

• VendorItem: The vendor's item number. If this field exists and the Item is not provided, this field
is used to find the item number. If both fields exist, this field is not used.

For more information, go to the IDM Home Page in the IDM application and click How to Capture
a Document.
Draft Comments Verify that this is still true ?

3 In IDM, ensure that the IDM_Configuration.xml has been imported and the CS_SupplierInvoice
document type is available.

4 Configure the IDM Capture plug-ins for each Batch Class that is set up within IDM Capture.

Draft Comments Verify where information about confguring the plug-ins for the bach class is
provided? . Might be in the doc/appendix that I am adding? I do not think it's covered in the docs
listed below.

See the Infor Document Management Capture Configuration Guide for Infor Operating Service.

5 Configure IDM Capture to publish BODs to IDM.

See the Ephesoft documentation for more information.
Draft Comments Where should I refer them for this information? I don't see information about
configuring IDM Capture (Ephesoft) to publish BODs in the IDM Capture docs. I also don't see
anything very definitive in the M3 doc that I'm supposed to mimic.
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Configuring BODs for optional products in the CloudSuite
Additional connection points for optional ION-enabled applications are set up by the Infor Cloud team
in your CloudSuite, if your license includes them. The Infor Cloud team configures the other applications
to work with ION.

You must set up the documents (BODs) that can be sent and received by each application connection
point, and then configure and activate document flows between CloudSuite Industrial and that application.

Adding BODS to the Infor CRM connection point
If CRM is included in the CloudSuite, the CRM connection point was set up in Configuring BODs for
the Infor CRM integration with Infor Ming.le on page 39, and some BODs were added for integration
with Infor Ming.le. You must add more BODs for the integration between CRM and Infor CloudSuite
Industrial.
Draft Comments  This paragraph will change when CRM is included in MT, to match the EAM and
XM topics.

1 If a CRM connection point exists in ION Desk, select the connection point.

2 In the CRM connection point's Documents tab, click + and add these documents for the integration
with CloudSuite Industrial:

Send from
Application

Receive in Applica-
tion

Document

XProcess.BillToPartyMaster

XProcess.ContactMaster

XProcess.CustomerPartyMaster

XProcess.Quote

XProcess.SalesOrder

XProcess.ShipToPartyMaster

XSync.BillToPartyMaster

XSync.CodeDefinition

XSync.ContactMaster

XSync.CustomerPartyMaster

XSync.CustomerReturn

XSync.Invoice

XSync.ItemMaster

XSync.Location

XSync.PayFromPartyMaster
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Send from
Application

Receive in Applica-
tion

Document

XSync.Person

XSync.Quote

XSync.ReceivableTransaction

XSync.SalesOrder

XSync.Shipment

XSync.ShipToPartyMaster

Configuring BODs for the Infor EAM connection point
1 If an EAM connection point exists in ION Desk, select the connection point.

2 In its Documents tab, add these documents, if they don’t already exist:

Send from
Application

Receive in Applica-
tion

Document

XProcess.Requisition

XSync.CodeDefinition

XSync.PurchaseOrder

XSync.ReceiveDelivery

XSync.SupplierPartyMaster

Configuring BODs for the Infor Expense Management connection
point
1 If an Infor Expense Management connection point exists in ION Desk, select the connection point.

2 In its Documents tab, add these documents, if they don’t already exist:

Send from
Application

Receive in Applica-
tion

Document

XSync.CodeDefinition

XSync.CurrencyExchangeRateMaster

XSync.EmployeeTimesheet
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Send from
Application

Receive in Applica-
tion

Document

XSync.ExpenseReport

XSync.Personnel

XSync.ProductionOrder

XSync.ProjectMaster

XSync.RemittanceAdvice

XSync.ServiceOrder

Configuring BODs for the IDM connection point
Update the Infor Document Managementt connection point:

1 In ION Desk, select Connect > Connection Points.

2 Select the IDM connection point.

3 In its Documents tab, add this document, if is doesn’t already exist:

Send from
Application

Receive in Applica-
tion

Document

XSync.CaptureDocument

4 Save your changes.

Setting up document flows between the ERP and optional
BOD-enabled products in the CloudSuite
After the documents are associated with each of the connection points, set up or complete the document
flows in ION Desk between CloudSuite Industrial and the other application.

Note:  The document flow is only one part of the integration setup. See the appropriate integration
guide for the rest of the setup steps.

Creating the CSI > CRM > CSI document flow
Draft Comments When Scott T's XMLs are included in the Cloud provisioning, remove the "CSI >
CRM > CSI document flow" and use this one instead. For now, that one is marked as "WIP."
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Note:  You must read the Infor CloudSuite Industrial Integration for Infor CRM to understand the
integration and to follow any additional configuration steps in the applications, before you activate this
document flow.

1 In ION Desk, select Connect > Document Flows.

2 Create one document flow for each site that is connected to CRM. Name it CSI_site_CRM_CSI.

3 In the properties pane for each of the application boxes, click Add and add the appropriate connection
points.
Draft Comments Some of this will probably change.

4 Click the document icon between From CSI and CRM and include these documents:

• Sync BillToPartyMaster
• Sync CodeDefinition
• Sync ContactMaster
• Sync CustomerPartyMaster
• Sync CustomerReturn
• Sync Invoice
• Sync ItemMaster
• Sync Location
• Sync PayFromPartyMaster
• Sync Person
• Sync Quote
• Sync ReceivableTransaction
• Sync SalesOrder
• Sync Shipment
• Sync ShipToPartyMaster

5 Save the document flow.

6 Click the document icon between CRM and To CSI and include these documents:

• Process BillToPartyMaster
• Process ContactMaster
• Process CustomerPartyMaster
• Process Quote
• Process SalesOrder
• Process ShipToPartyMaster

7 Save the document flow.

8 If you plan to send CRM data to more than one CloudSuite Industrial site, follow these additional
steps:

a Drag a Parallel object into the flow between CRM and To CSI. Add one line for each site.
b Drag one application object for each site onto each line. Add the connection point for that site.
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c Drag a Filter object on the first line. This filter directs inbound Process BOD documents from
CRM to the appropriate CloudSuite Industrial accounting entity (site).

d In the Filter Properties area, specify a name for the filter that includes the site name and the BOD
attribute, for example, LAAcctEntity.

e Click the Attributes tab.
f Click Add and expand one of the BODs to select its AccountingEntityID attribute. Click OK.

g Click in the Name column and change the attribute name to describe the BOD and attribute, for
example,BillToAcctEntity. This will make it easier to link the attributes to the conditions.

Repeat steps f and g to create attributes for the other BODs in the list. The finished list of attributes
should look like this example:
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h In the Conditions tab of the filter, select a BOD in the Document field. For example, select
BillToPartyMaster.

i Click Add and create a condition for the BOD attribute, which is used to filter BODs for the specific
site.

Specify this information:

Name
For the condition name, specify the filter attribute that you created in the Attributes tab for the
BOD. For example, for the BillToPartyMaster BOD, specify the BillToAcctEntity attribute.

Type
Set this to Attribute Value Comparison.

Attribute
Select the filter attribute, for example BillToAcctEntity.

Operator
Select in set.

In Set
Specify the site name, for example, LA.

j Click OK.

The finished condition should look like this example:
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k Select the same BOD in the Document field and select the matching condition in the Used
Condition field. For example, select BillToAcctEntity.

l Save your changes to the filter.
m Copy the filter, place it on each of the branches, and then rename and edit the filter to apply to

each site.

Delete any empty branches.

9 Save your changes.

Do not activate the document flow until you complete the steps in the integration guide.

Creating the CSI > EAM > CSI document flow

Draft Comments  For CSI 10, this topic will be replaced by "Completing the erp_eam document flow"
after RS 7988 (ION Content Automation) is completed.

Note:  You must read the Infor CloudSuite Industrial Integration for Infor EAM to understand the
integration and to follow any additional configuration steps in the applications, before you activate this
document flow.

1 In ION Desk, select Connect > Document Flows.

2 Create a document flow called CSI_To_EAM_To_CSI.
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3 In the properties pane for each of the application boxes, click Add and add the appropriate connection
points.

4 Click the document icon between CSI_1 and EAM and include these documents:

• Sync PurchaseOrder
• Sync ReceiveDelivery
• Sync SupplierPartyMaster

5 Click the document icon between EAM and CSI_2 and include this document:

• Process Requisition

6 Save the flow but do not activate it until you complete the steps in the integration guide.

Creating the CSI > XM > CSI document flow

Draft Comments  For CSI 10, this topic will be replaced by "Completing the erp_eam document flow"
after RS 7988 (ION Content Automation) is completed.

Note:  You must read the Infor CloudSuite Industrial Integration for Infor Expense Management to
understand the integration and to follow any additional configuration steps in the applications, before
you activate this document flow.

1 In ION Desk, select Connect > Document Flows.

2 Create a document flow called CSI_XM_CSI.

3 Drag a parallel item into the document flow and add the four application boxes.

4 In the properties pane for each of the application boxes, click Add and add the appropriate connection
points:

• Associate the Sys From CSI and ER to CSI applications with the CloudSuite Industrial connection
point(s).

• Associate the Sys To XM and ER from XM applications with the Infor Expense Management
(XM) connection point.

5 Save the document flow.

6 Click the document icon between Sys From CSI and Sys To XM and add these documents:

• Sync CodeDefinition
• Sync CurrencyExchangeRateMaster
• Sync Personnel
• Sync ProductionOrder
• Sync ProjectMaster
• Sync RemittanceAdvice
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• Sync ServiceOrder

7 Save the document flow.

8 Click the document icon between ER From XM and ER To CSI and add these documents:

• Sync EmployeeTimesheet
• Sync ExpenseReport

9 Save the flow but do not activate it until you complete the steps in the integration guide.

Creating the CSI > IDM document flow

Draft Comments  For CSI 10, this topic will be replaced by "Activating the erp_idm document flow"
after RS 7988 (ION Content Automation) is completed.

Create this document flow only if you are using IDM Capture (using Ephesoft) to send scanned
documents as BODs to Infor Document Management. For more information about this integration, see
Configuring IDM on page 65.

1 In ION Desk, select Connect > Document Flows.

2 Create a document flow called erp_idm.

3 In the properties pane for each of the application boxes, click Add and add the appropriate connection
points.

4 Click the document icon between From_IDM and To_CSI and include this document:

• Sync CaptureDocumen

5 Save the flow but do not activate it until you complete the steps in Configuring IDM on page 65.

Importing sample ION workflow content
Optionally, you can import some sample workflow content into ION Desk, to better understand how
alerts, workflows, and activation policies are used for communication between ION and CloudSuite
Industrial.

Note:  These samples are not currently supported by Infor.

1 In the Infor Xtreme Support portal, search for solution 1440389. Download the SL_ION_Con
tent.zip file to a local folder. Unzip the file to extract a set of files that you will import into Infor
Ming.le and ION Desk.

2 Open Infor Ming.le and import the distribution groups:

a From the user menu, select User Management.
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b From the menu on the User Management page, select Manage > Groups > Distribution
Groups.

c Click the Import icon.

d Browse to your local folder, select the SL-DistributionGroups.csv file, and click Import.

e Verify that the log messages indicate that all rows were added successfully, and click Close.

The new distribution groups are displayed on the Groups page.

3 Open ION Desk and import the sample monitors:

a Select Monitors & Workflows > Monitors.
b Click the Import icon.
c Browse to your local folder, select the SL-Monitors.xml file, and click OK.
d Verify that the list shows successfully imported monitors and click OK.

4 In ION Desk, import the sample workflows. Select Monitors & Workflows > Workflows and import
SL-Workflows.xml.

5 In ION Desk, import the sample activation policies. Select Monitors & Workflows > Activation
Policies and import SL-ActivationPolicies.xml.

6 Activate each of the sample monitors, workflows, and activation policies by clicking the Activate
button.
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Chapter 5: Configuring your web browser

Configure your browser for use with Infor Ming.le.

Allowing popups for browsers
Ensure that any browser that is used with CloudSuite Industrial allows pop-ups. If pop-ups are disabled,
the help will not work properly.

Avoiding multiple connections in a browser
You can have as many configurations as you want in a single application or server instance.

However, you cannot have multiple concurrent connections to the same CloudSuite Industrial application
server in a single browser, even using different configurations. The session connection attributes use
the server name as the key and are not differentiated by configuration name.

Setting up compatibility for Internet Explorer browsers
Note:  Follow these steps only if you are using Internet Explorer as your browser.

Some Infor Ming.le and CloudSuite Industrial versions of Internet Explorer might be incompatible. If
so, a message is displayed to indicate that your browser is not supported. In that case, before you can
run CloudSuite Industrial in Infor Ming.le, you must change your compatibility view settings in your
browser.

1 In the browser, click Tools > Compatibility View Settings.

2 Clear the Display intranet sites in compatibility view option.

Infor CloudSuite Industrial Configuration Guide - Cloud Edition | 94DRAFT
 

Configuring your web browser



Chapter 6: Configuring ERP access through Infor
Ming.le

Users, roles, and person IDs are initially defined in Infor Ming.le and shared with all of the other
applications that run through the Infor Ming.le portal. Roles and some user information can later be
modified in CloudSuite Industrial.

Configuring Single Sign On
All applications within the CloudSuite are preconfigured to use Infor Ming.le/IFS to allow a single sign
on. No additional configuration is needed.

If you want to integrate your existing on-site identity management (single sign on) system with this
CloudSuite, contact Infor Consulting Services or your Infor provider.

Users and roles
Because Infor Ming.le is the system of record for users, you must set up users in Infor Ming.le. The
users are then synchronized through BODs to other BOD-enabled applications in the Infor Ming.le
portal. After the users are synchronized to your application, you can continue the user setup in your
application.

You can perform these user management tasks in Infor Ming.le:

• Create users, including manual import of users
• Update users
• Delete or deactivate users
• Reset passwords
• Monitor recent user activity and mobile sessions
• Manage sessions
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How Infor Ming.le users and roles work with ERP users and groups
When you create or update a user in Infor Ming.le, the information associated with that user is used to
automatically set up some user information in CloudSuite Industrial. This association is handled through
Sync SecurityUserMaster BODs that are passed through ION.

CloudSuite Industrial groups are mapped to security roles in Infor Ming.le. The list of available CloudSuite
Industrial groups must be updated and maintained in CloudSuite Industrial – not in Infor Ming.le -
because the types of roles and the names of roles are dependent on the requirements of CloudSuite
Industrial. After the groups are set up in CloudSuite Industrial, they are synchronized to Infor Ming.le
through the Sync SecurityRoleMaster BOD, so that Infor Ming.le is aware of all possible roles. The
ability of security roles to perform specific operations and access specific data is enforced by CloudSuite
Industrial, not Infor Ming.le.

Infor Ming.le provides a default Infor-SystemAdministrator role that allows for full access to all applications
that are linked to Infor Ming.le. CloudSuite Industrial has an Infor-SystemAdministrator group or role
that allows access to all CloudSuite Industrial screens. When a user who has the
Infor-SystemAdministrator role inInfor Ming.le is synchronized to CloudSuite Industrial, that user
automatically has access to all CloudSuite Industrial forms.

For more information about these BODs, see User and role BOD usage on page 137.

Configuring user access to the ERP through Infor Ming.le

Caution:  The Infor Cloud team configures the initial Infor Ming.le system administration user and its
roles, as well as several other required accounts. We recommend that you do not change the
configuration of this initial system administrator or the other required accounts.

You must add other users in Infor Ming.le before they can access CloudSuite Industrial through Infor
Ming.le.

1 From the Infor Ming.le User Menu, select User Management.
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2 On the Users page, follow these general steps to add users. See the Infor Ming.le online help for
more information.

a Click + to add a user.
b Clear the Send Invitation option so that you can send the invitation later, after you have completed

the user setup.
c Save your changes.
d Click the details icon  to view details for the user.

Note:  The IFS Person ID will be used to synchronize personnel records with CloudSuite Industrial.
It is generated automatically and should not be changed.

e In the Security Roles tab, assign the user to one or more roles, and click Add & Close.

In order for users to access CloudSuite Industrial through Infor Ming.le, they must be assigned
at least one CloudSuite Industrial role.

You might not see all of the application-specific roles that you need. If you do not see the roles
you need, those roles can be added and assigned later from within CloudSuite Industrial.

f Save your changes.

The information is sent through BODs to CloudSuite Industrial after you save your changes.

3 Open CloudSuite Industrial from the App Menu.

4 If prompted, select a configuration, which is linked to one of your CloudSuite Industrial sites. If you
plan to use one site as a master site, select the configuration for the master site.

5 In CloudSuite Industrial, select Form > Open and open the Users form.

6 In the Users form, click the filter toolbar button  to see all of the users who were defined in Infor
Ming.le.
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7 Update the information for each user to specify additional required or optional fields that are not
shared with Infor Ming.le. See the CloudSuite Industrial online help for more information.

a After you add your users in Infor Ming.le, verify that the user information has been sent through
BODs to CloudSuite Industrial. This information should be shown in the CloudSuite Industrial
Users form:

• The user name (email address) that you set for each user in Infor Ming.le is shown in the
User Name field.

• The IFS Person ID that was set for each user in Infor Ming.le is shown in the Workstation
Domain/ID field.

These values should not be changed.

b Assign the user’s form editing permission level, PO requisition limit, and multi-site group
authorization, as needed. See the online help.

c Set the user’s password for the CloudSuite Industrial web client or click once client.

(This is not the same password that is used to log into the Infor Ming.le portal. The Infor Ming.le
portal password uses the IFS ID tied to the Workstation ID, so no additional user login is required
to access the CloudSuite Industrial application in Infor Ming.le.)

When users access CloudSuite Industrial through the web client or the click once client rather
than through Infor Ming.le, they must know this password.

d Ensure that the email address that you set for each user in Infor Ming.le is shown in the Primary
Email Address on the Users form. This value should not be changed. We recommend setting
these additional fields for the user:

e In the Groups tab, click in the grid and select Actions > New to add a new row.

Infor CloudSuite Industrial Configuration Guide - Cloud Edition | 98DRAFT
 

Configuring ERP access through Infor Ming.le



f Click in the Group Name field to view the list of groups. Add any groups to which this user should
belong. If you were able to assign the groups as security roles for the user in Infor Ming.le, you
will see them listed here. Otherwise, you can assign the additional groups here.

g Click User Modules and assign the appropriate license modules to the user.

By default, users who are originally created in Infor Ming.le and sent through BODs to CloudSuite
Industrial are assigned a Transactional license in CloudSuite Industrial. This is handled through
the Admin License Module Name setting in the Process Defaults form.

Note:  Some modules such as Service and QCS are separately licensed. See Configuring users
for separately licensed modules on page 99.

h Save your changes.

8 In Infor Ming.le User Management, select the user’s record, and then select Action > Resend
Invitation.

The user receives a notification with a link that provides user-specific access to Infor Ming.le and
to CloudSuite Industrial.

Configuring users for separately licensed modules
If your product includes separately licensed modules such as Quality Control (QCS), Service, or Tax
Interface, follow these steps to ensure that users have access to those modules.

1 Log into CloudSuite Industrial.

2 In the Optional Modules form, ensure that Enabled is selected for the modules for which you have
purchased licenses.

3 In the Users form, click the filter button on the toolbar to show all defined users.

4 In the grid on the left, select a user who needs licensing for an optional module.

5 Click User Modules to display the license modules assigned to the current user.

6 To add a license for the user, click the Create button on the toolbar.

7 In the Module Name field, select a license module for the user, for example, ServiceManagement
for the Service module or QualityControlSolution for the QCS module.

Required: For business partners in a demo environment, your administrative user must be licensed
for these modules:

• QualityControlSolution
• ServiceManagement
• TaxInterface

8 Click the Create toolbar button again to add another license module for the user, and repeat until
all licenses for that user are added.

9 Save your changes.

10 Repeat these steps for any other users that must be licensed for the optional modules.
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Configuring additional system administrator access to all tenant
applications through Infor Ming.le
Note:  The Infor Cloud team initially configures system administrator access for one user between Infor
Ming.le and CloudSuite Industrial.

1 From the Infor Ming.le User Menu, select User Management.
2 On the Users page, click the Detail icon for one of the users that you want to make an administrator.

3 In the Security Roles tab for that user, click + to add roles.

4 In the Search field, specify Admin to filter for all administration roles, and click the search icon.

5 Select the check box at the top of the column, to select all admin roles.

6 Click Add & Close.

7 Click + again and specify Mingle in the filter field. Add all displayed roles to this user.

8 Click + again and specify Homepage in the filter field. Add all displayed roles to this user.

9 Click the Save icon on the Security Roles tab to save the roles for this user.

Configuring additional system administrator access to the ERP
through Infor Ming.le
Note:  The Infor Cloud team initially configures system administrator access for one user between Infor
Ming.le and CloudSuite Industrial.

1 In Infor Ming.le, add the Infor-SystemAdministrator role to the appropriate users.

After you update the user information, a BOD is sent from Infor Ming.le to CloudSuite Industrial to
synchronize the system administrator users with this role.
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2 Assign additional system administration roles, either in Infor Ming.le or in the CloudSuite Industrial
Users form, to the appropriate users.

Setting up additional roles or groups
Predefined security roles (groups) are used in both the CloudSuite Industrial application and Infor
Ming.le. If you need to create security roles groups that are specific to your company for use with
CloudSuite Industrial, follow these steps.

1 In CloudSuite Industrial, use the Groups form to create any additional groups (security roles) that
you need in order to access specific forms, programs, and logical folders.

Your updates to the list of groups/roles are then sent to Infor Ming.le through the
Sync.SecurityRoleMaster BOD. The information from this BOD is used in Infor Ming.le to automatically
create a matching security role.

2 Associate the security roles with users. This can be done in either Infor Ming.le or CloudSuite
Industrial:

• To associate security roles with users in Infor Ming.le:
a Select User Management.
b Select a user.
c Click the Details icon.
d In the Security Roles tab, click +.
e Select the roles you want for the user, and click Add & Close.

Infor Ming.le generates a Sync.SecurityUserMaster BOD for each user to which a role was added.
It sends the BOD to all applications that run in the Infor Ming.le portal. CloudSuite Industrial uses
the information from this BOD to associate the role or group with the CloudSuite Industrial user
record.

• To associate groups (roles) with users in CloudSuite Industrial, go to the Users form, filter for
the user, and use the grid on the Groups tab to associate the user with the appropriate groups.

CloudSuite Industrial generates a Process.SecurityUserMaster BOD which is sent to Infor Ming.le.
Infor Ming.le then sends another BOD to all applications that run in the Infor Ming.le portal, to
update the user records in all applications.

Note:  Do not manually create a security role in Infor Ming.le that does not exist in CloudSuite
Industrial.

If you delete a role in either CloudSuite Industrial or Infor Ming.le, you must also delete the
corresponding role in the other application.

Automatic login and selecting configurations
When users first access CloudSuite Industrial through Infor Ming.le, they see a dialog box. Because
of Single Sign On, the user ID and password are not requested; however, users must select a CloudSuite
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Industrial configuration. The Use Workstation Logon option on this dialog box is hidden and is
automatically selected for the user.

Subsequent logins depend on how the user signs in and out of the application and Infor Ming.le:

• If users sign out of the CloudSuite Industrial application before exiting Infor Ming.le, then the next
time they open the CloudSuite Industrial application, they must select a configuration.

• If users close the browser without signing out, or exit Infor Ming.le without signing out of CloudSuite
Industrial, then the next time they open the CloudSuite Industrial application, the previous
configuration is automatically selected and no dialog box is shown. To switch to a different
configuration, the user can select Form > New Sign In.

Verifying user access
To verify that users were created properly and can access the appropriate forms in CloudSuite Industrial:

1 Log into Infor Ming.le portal as a user. The user must belong to a role that is defined as an
administrator in both Infor Ming.le and CloudSuite Industrial.

2 From the App Menu, open CloudSuite Industrial.

3 If prompted, select the appropriate configuration and click OK. The application session is opened.

4 Open the Users form and verify this information for several users:

• User Name matches the Email address in Infor Ming.le.
• Workstation Domain/ID matches the IFS Person ID in Infor Ming.le.
• Groups that you assigned to this user are set as roles in Infor Ming.le.

5 Sign out of the application and Infor Ming.le. Close the browser.

6 Log into Infor Ming.le and CloudSuite Industrial as a non-administrative user who has access.

7 Ensure that you can open any forms that the user has authorization to open, and that you cannot
open any forms for which the user is not authorized. as a non-administrative user who has access
to both

Setting up distribution groups
Optionally, you can set up distribution groups in Infor Ming.le for CloudSuite Industrial users who require
access to ION in order to view or update information or to troubleshoot errors.

See the Infor Ming.le online help.
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Service accounts
The Infor Ming.le Service Accounts page shows accounts that have been created to allow applications
a resource owner grant to contact the Infor Authorization Service to obtain a token for use in making
API requests.
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Chapter 7: Configuring the ERP

Configure the CloudSuite Industrial ERP application using these general steps.

Note:  Consider using an Infor Implementation Accelerator to speed up your implementation.
Implementation Accelerators provide overviews, key capabilities, definitions, and configuration of codes
and parameters for specific business processes. For more information, contact your Infor representative.

This section assumes that you have already set up the users and groups (roles).

1 Open the CloudSuite Industrial application in the Infor Ming.le portal.

2 Set up a file server and logical folders.

See “Setting up a File Server for ERP in the Cloud” in the online help.

3 Set up the application to send reports by email to users.

On the Intranets form, click the filter button to show the predefined records.

In the CORP intranet record, select Send Email Notification. The Infor Cloud Team has already
set up the required fields for SMTP, TaskMan and SSRS for the CORP intranet. These fields should
not be changed.

4 Define report options.

You do not print a report directly from the application in the cloud. When you click Print or Preview,
by default the report is displayed as a PDF in your browser, and you can save or print it from there.

In the Report Options form, the Infor Cloud team has already set default options for all users. Do
not modify this default record, which has a blank User field value. However, you can add records
for individual users or reports, and change some of the settings specifically for that user or report.
For example, you can set Email Notification to Yes for some reports. You cannot specify a printer
or a different Output Directory. See the online help for information about all of the options.

5 If your tenant has multiple sites:

• On the Sites/Entities form, set the Time Zone for each site. Do not change any of the other site
information on this form.

• Use the Multi-Site Planning Guide - Cloud Edition and the Multi-Site Implementation Guide -
Cloud Edition to set up replication between the sites and to configure the rest of the financial,
parameter and master data for the application.

Specify a master site for the intranet, in order to maintain customers, vendors, and items for all
sites from the master site. You can optionally use the Intranet Shared User Tables form to
share the Authorizations_mst, UserGroupMap_mst, and/or user_local_mst tables if you want to
share users and group authorizations information between sites. Do not use the Intranet Shared
Tables form; those tables are already shared because the sites are all in one database.

6 If your tenant has a single site, follow these steps, using the online help:
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• On the Sites/Entities form, set the Time Zone. Do not change any of the other site information
on this form.

• Set the invoice length on the Order Entry Parameters form.
• Set up the chart of accounts and financial information.
• Set up other parameter forms.
• Set up master data such as customers, vendors, and items.

7 Set master data to standardized values.

To ensure consistent master data between integrated applications, use the ISO standard values
where applicable. You can map existing non-standard units of measure, currencies and countries
to ISO values through these CloudSuite Industrial forms:

• Currency Codes
Note:  ISO currency codes are required for some integrations. ISO currencies are not defined
as part of an initialized database and must be set manually.

• Countries
• Unit of Measure

8 The values that you must configure in CloudSuite Industrial for integrations–for example, customer,
vendor or item master records, or system parameters–often depend on the application with which
CloudSuite Industrial will exchange information. For more information, see the appropriate application
integration guide.
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Chapter 8: Verifying drillbacks to the ERP

Infor Ming.le users can share screens and business data in some ION-enabled products that are
integrated with CloudSuite Industrial. The screens and business data can include embedded drillback
links to CloudSuite Industrial. If a screen or business data is associated with a BOD that was sent from
CloudSuite Industrial, and the screen or data has an associated drillback link, then users can click the
link to view the screen that has the supporting information for the source transactions.

For example, you might have a Homepage widget in Infor Ming.le that draws its data from the
CustomerPartyMaster BOD in CloudSuite Industrial. If the user selects the drillback option from that
widget, it opens the Customers form in CloudSuite Industrial.

A drillback link can be defined for each type of BOD noun, for example, SalesOrder or ItemMaster.
The link is configured to open a specific CloudSuite Industrial screen for that noun. Not every BOD
noun has an associated drillback view in CloudSuite Industrial.

Available drillbacks
This table lists the views that are currently available and the CloudSuite Industrial form that is launched:

CloudSuite Industrial formDrillback viewBOD Noun

CustomersBillToPartyViewBillToPartyMaster

CustomerSalesContactCrossReferencesContactMasterViewContactMaster

CustomersCustomerViewCustomerPartyMaster

RMAsCustomerReturnViewCustomerReturn

MaterialTransactionsAdjustmentOrderViewInventoryAdjustment

ItemsItemViewItemMaster

CustomersPayFromPartyViewPayFromPartyMaster

SalespersonsEmployeeViewPerson

PurchaseOrdersPurchaseOrderViewPurchaseOrder

EstimatesQuoteViewQuote

MaterialTransactionsReceiptViewReceiveDelivery
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CloudSuite Industrial formDrillback viewBOD Noun

VendorsRemitToPartyViewRemitToPartyMaster

PurchaseOrderRequisitionsRequisitionViewRequisition

CustomerOrdersSalesOrderViewSalesOrder

VendorsShipFromPartyViewShipFromPartyMaster

MaterialTransactionsShipmentViewShipment

VendorsSupplierViewSupplierPartyMaster

Loading the BODs that are used in drillbacks
In order to use these drillbacks, you must perform an initial load of the BODs listed in “Available
drillbacks,” using the Replication Document Manual Request Utility in CloudSuite Industrial.

See Publishing initial data on page 111.

Verifying a drillback
Drillbacks are displayed in the Infor Ming.le user interface as links that open CloudSuite Industrial to
a specific screen filtered for specific results. For example, an Infor Ming.le search result, alert, or share
can include a link to the form with a reference to specific CloudSuite Industrial data.

To verify that the drillbacks are working:

1 From the App menu, open CloudSuite Industrial.

2 Open a form that has a drillback, for example, Customers.

Note:  The user interface does not indicate whether a screen has a drillback. In order for a screen
to have a drillback, a drillback must be configured and a business context message must also be
sent. See Available drillbacks on page 106 and Understanding business context messages on page
121.

3 Display the information that you want to share, for example, the record for a particular customer.
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4 Click the Share icon on the Infor Ming.le screen.

5 On the Share overlay, verify that the drillback icon is displayed, add a comment, and click Share.

6 In the Infor Ming.le feed, find the message that contains the drillback icon, and click the drillback to
verify that it is working.
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Chapter 9: Configuring applications to send and
receive BODs in ION

This section describes how integrations between this application and other applications use ION to
send and receive BODs, and how to set up or modify document flows between applications. For details
about a specific integration, see the appropriate integration guide.

Tasks performed by the Infor Cloud team
The Infor Cloud team has already set up CloudSuite Industrial so that it can generate BODs and place
them in a message outbox where ION Connect can retrieve them. The team also set up the inbound
message configuration, so that BODs sent to this application can process those messages.

The team pre-configured some initial replication rules, as well as logical IDs, tenants, and accounting
entities (sites) in CloudSuite Industrial:

• The team set up a logical intranet called InforESB in CloudSuite Industrial. This intranet is used for
ION communications. If the same tenant ID is used for all sites on this intranet, the Infor Cloud team
specified in the Intranets form. The tenant ID specified for each site on the Sites/Entities form
matches the tenant ID used in ION for other connecting products.

• On the Sites/Entities form in CloudSuite Industrial, the team set up a record for a logical "site"
called InforBUS that is used for communication with ION, as well as records for the other sites in
your system.

• On the Replication Rules form, the team set up replication rules for category ESB where each of
your sites is the Source Site and the InforBUS site is the Target Site.

In ION Desk, the Infor Cloud team preconfigured some connection points and document flows:

• The team set up connection points for all CloudSuite Industrial sites, Infor Ming.le, Infor Document
Management and provided the list of documents that can be sent and received by these connection
points.

• If your CloudSuite includes Infor CRM, Infor EAM, or Infor Expense Management, the Cloud team
set up connection points for these applications, and might (or might not) have set up the list of
documents for those connection points.

• The team configured and activated a document flow between CloudSuite Industrial and Infor Ming.le
to pass user account and role (group) information.
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• The team set up and activated a Listener for Infor Ming.le, which automatically forwards all BODs
for specified verbs to Infor Ming.le. It is used to view drillbacks from CloudSuite Industrial in Infor
Ming.le. See the Infor ION Desk User Guide - Cloud Edition for information about message listeners.

Tasks performed during Post Provisioning
If your CloudSuite includes the optional CRM, EAM, or XM applications, the Post provisioning steps
on page 18 completed and activated the document flows, and added any needed BODs to the connection
points for these applications.

These tasks were performed by Infor Consulting Services, a Business Partner, or an administrator at
your company.

How products connect to ION
The Infor Cloud team set up connection points in ION Desk for each of your Infor cloud applications
(and CloudSuite Industrial sites) that use ION. You cannot modify these connection points, but you
can add to the list of documents that can be sent or received by the connection point.

In an integration between two BOD-enabled products, document flows are set up to define the BODs
that flow between the application connection points.

A connection point can be reused multiple times in one or more document flows. See the section on
ION Connect Modeling in the Infor ION Desk User Guide - Cloud Edition for additional information
about connection points and document flows.

If you remove from a connection point a document that is used in a document flow, an error is reported
in the document flow messages pane.

Connection points are not activated separately. When you activate a document flow, the associated
connection points are activated.

Integrating to BOD-enabled applications that are not in the
CloudSuite
Documents and document flows for CloudSuite Industrial, Infor Ming.le, IDM, and optional applications
in the CloudSuite (CRM, EAM and Infor Expense Management) were set up as part of the Infor Cloud
team provisioning or the Post provisioning steps on page 18.

Draft Comments Add d/EPM to the list of optional applications above when the integration is released.
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Optionally, if you want to send and receive BODs to or from another BOD-enabled application that is
not part of the CloudSuite, follow these general steps. See the Infor ION Desk User Guide - Cloud
Edition for detailed information.

Note:  If you have an Infor consultant working with you, the consultant might handle these steps.

1 If an integration guide exists between the applications, refer to that guide instead of these steps.

2 Create a connection point for the other application. You must know the application connection
information and have the appropriate utilities to connect to Infor ION from the other application if it
is not in the Infor Cloud. If the other application is in the Infor Cloud, the Infor Cloud team must add
the connection point for you.

3 In the Documents tab of the connection points, include the BODs that can flow to and from the
applications.

• See Outbound BODs from the ERP to integrated applications on page 153. Select Send from
Application for each of these BODs.

• See Inbound BODs to the ERP from integrated applications on page 156. Select Receive in
Application for each of these BODs.

4 Optionally, you can also add custom document types. See the Infor ION Desk User Guide - Cloud
Edition.

5 Define a new document flow that includes connection points for both CloudSuite Industrial and the
other application.

6 Define the documents that flow between the applications, and the direction that they flow.

7 Save the document flow.

8 Activate the document flow.

Publishing BODs
This section provides a general description of how to publish, or generate, BODs from CloudSuite
Industrial, and how to verify that data is flowing out of your application into ION.

For the steps to publish BODs for a specific integration, see the appropriate integration guide.

When you publish BODs in CloudSuite Industrial, they are placed in the Replication Document
Outbox, where ION can retrieve them. The published BODs are then available to any application that
subscribes to the BODs through ION. Products can subscribe to BODs either through a document flow
or through a listener.

Publishing initial data
During normal processing, BODs are automatically generated (published) when a user makes a data
change or completes a transaction. However, when you start a new integration with another application,
you must manually publish BODs that pass the current set of data from your application to another
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application, so that the base systems are synchronized. The BODs are placed in the Replication
Document Outbox, from which ION retrieves them and passes them to the other application.

To publish initial ERP master and transaction data into BODs that are placed in the Replication
Document Outbox:

1 In CloudSuite Industrial, open the Replication Document Manual Request Utility.

2 Select Initial Load so that the data is processed as an insert, that is, as new data.

3 Select the BODs to include in the data load. The BODs you select are different for each integration.
See the appropriate integration guide for the BODs to load.

Note:  If you select multiple process BODs at one time, the BODs are processed in alphabetical
order. However, you must load certain BODs in a specific order, to prevent errors in the integration
due to missing data. See BOD dependencies on page 112.

4 Click Process to process the selected BODs.

5 Continue to select and process BODs until all of the BODs are processed that are required for a
specific integration.

6 Repeat this process at each CloudSuite Industrial site.

When you use this utility to publish BOD data, the current date is used for all Status/EffectiveDateTime
elements.

After the initial data load, CloudSuite Industrial automatically publishes BODs whenever users change
certain data or when certain transactions occur in CloudSuite Industrial. For a list of the events that
generate BODs, see Business events that generate outbound BODs on page 142.

BOD dependencies
Be aware that you must load these BODs in this order to prevent errors in the integration due to missing
data:

• CodeDefinition
• ItemMaster
• Location
• CustomerPartyMaster
• BillToPartyMaster
• ShipToPartyMaster
• SalesOrder
• Shipment
• Invoice

Turning off BOD replication to reduce traffic
Draft Comments This is the Cloud version of this topic.
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CloudSuite Industrial can generate hundreds of BODs per day. By default, a BOD is generated whenever
the BOD trigger occurs. For example, a BOD is generated every time a user creates a new customer
order, or every time an invoice is created.

Unless you have integrations set up where other applications will receive the BODs, there is no need
to generate most of the BODs. Use these steps to stop publishing all unnecessary BODs.

1 Open the Replication Categories form.

2 Specify ESB as the Category and click the filter.

3 To stop publishing a BOD, update its Trigger* record in the ESB replication category. Select the
appropriate Skip Method check box.

This example shows how to turn off the Sync.ItemMaster BOD:

4 We suggest that you turn off all of the triggers except these:

• FlushBusCacheForSiteSp
• FlushBusParmsForSiteSp
• SendEntireBodSp
• TriggerBODConfirmSp
• TriggerPulseNotificationSyncSp
• TriggerSecurityPermissionMasterSyncSp
• TriggerSecurityRoleMasterSyncSp
• TriggerSecurityUserMasterAcknowledgeSp
• TriggerSecurityUserMasterProcessSp
• TriggerSecurityUserMasterSyncSp

Note:  This list assumes that CloudSuite Industrial is only integrating with Infor Ming.le. If you are
integrating with other applications via BODs, you must turn on the triggers for the required BODs
when you integrate with the other applications. See the appropriate integration guide for the list of
outbound BODs.

5 Save your changes.
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Verifying the ION configuration
Use these tasks to verify that the connections are set up correctly.

Verifying that BODs are published
1 Use the information in Business events that generate outbound BODs on page 142 to determine

what user actions generate certain BODs.

2 Perform those user actions in CloudSuite Industrial.

For example, information from the Vendors form is replicated through the SyncSupplierPartyMaster
BOD, so you could change the vendor address and save your change.

3 Check the Replication Document Outbox form in CloudSuite Industrial to see if a BOD was
generated and marked as processed.

In our example, the SyncSupplierPartyMaster BOD is generated.

Depending on settings, the BODs might be removed immediately from the outbox after ION retrieves
them. In that case, you can check ION Desk OneView to verify whether the BOD was sent and
processed.

4 In ION Desk, review the messages by using ION Desk OneView or other ION Desk functions.

If messages are not displayed in ION Desk, check the CloudSuite Industrial Replication Document
Outbox form to see if the BODs were generated but not retrieved by ION.

5 If messages are not flowing, review the XML data for the BOD.

Verifying that ION receives data
To verify that ION is receiving BODs from CloudSuite Industrial, monitor these areas in ION Desk:

• Select Connect > Active Connection Points to show the message queue counts.
• Select OneView to show individual messages, if they are enabled.
• Select Connect > Error BODs to see if any errors were reported.

If you encounter problems, see Data is not flowing properly on page 140.

Verifying the data flow between applications
After you create and activate document flows to other applications, you can check the message inbox
area of the other applications, to ensure that data is flowing between the systems. See the other
application’s documentation to determine how to find the message inbox.
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Chapter 10: Configuring workflows and ION messages
for the ERP

You can configure workflows and ION messages for your application.

Draft Comments When the CSI content is approved (RS 8246), add this sentence: Example workflows
are provided.

ION messages
This table shows the types of ION messages:

DescriptionType

In ION Event Management, you can monitor business events and create
alerts when exceptions occur. BODs are published by applications
when business events occur. Monitors are processes that run in the
Event Management engine and evaluate these BODs by applying pre-
defined business rules: comparison conditions, value change conditions,
and document overdue timer based rules.

When exceptions are detected, these are reported as alerts to the
business users. The distribution list of alerts is included in the monitor
definition. Users can receive alerts on their homepages or by email.

Alert

A task is a workflow step that creates an entry in a user's task list. The
workflow stops until the user has completed this task, and then the next
step in the workflow begins.

Task

A notification is a workflow step that creates a notification in the user’s
task list. The workflow continues after the notification is sent to a user.
You can configure notifications to perform these actions:

• Send a message to inform the user that a certain point in the work-
flow has been reached.

• Optionally, include notes from previous steps.
• Display workflow parameters and structures.

A distribution list can be defined for notifications.

Notification
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DescriptionType

The ION Alarms mobile application for Android devices is available to
create monitors, called alarms.

In ION Desk, the business administrator can create alarm templates.

After the templates are activated, mobile users can use the templates
to create alarms in the ION Alarms mobile application. The alarm creator
can specify the distribution list for the resulting alert. See the Infor ION
Alarms Mobile Application User Guide.

The users receive the alert on their Infor Ming.le page, in the Infor
Ming.le mobile application, or by email.

Alarm

About alerts sent from the ERP to Infor Ming.le
CloudSuite Industrial can send PulseAlert BODs to ION that can be displayed as alerts in Infor Ming.le,
as shown in this process flow:

A Process PulseAlert BOD is generated when a business event associated with one of these publications
occurs in CloudSuite Industrial:

Where definedDescriptionPublication

Event: IdoOnItemUpdate, Seq
15

A customer was put on credit
hold

CustomerCreditHoldAlert

Event: CustomerInteractionFol-
lowupAlert, Seq 1

A follow-up is needed to a cus-
tomer interaction. Key Value 1
defines the customer number.

CustomerInteractionFollowUpAlert

Event: IdoOnItemUpdate, Seq
16

A customer order was put on
credit hold

CustomerOrderCreditHoldAlert

Event: IdoOnItemUpdate, Seq
17

An order was shipped to a cus-
tomer (for specific orders/cus-
tomers)

CustomerShipmentAlert
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Where definedDescriptionPublication

Trigger on dcsfc_mstIupA specified number of Data Col-
lection shop floor transaction er-
rors occurred. Key Value 1 de-
fines how any errors must be
generated before the user re-
ceives an alert

DCShopFloorTransactionErrorAlert

Trigger on jobmatl_mstIupThe quantity issued against a job
is more than required and the
total material cost (actual) of the
job exceeds the required cost by
a certain percent (tolerance) set
by the user

JobMaterialCostAlert

Trigger on jobroute_mstIupLabor hours for a job were more
than estimated

JobOperationHoursAlert

Trigger on job_mstIupThe completed quantity of a job
is greater than the released
quantity

JobOverProductionAlert

Trigger on job_sch_mstIupA job is projected to be late for a
specified customer. Key Value 1
is the customer number.

JobProjectedLateForCustomerAlert

Event: LateOrderShippingAlert,
Seq 1

At least one open order line for
a customer has a due date prior
to the current date. Key Value 1
is the customer number

LateOrderShippingAlert

Event: IdoOnItemUpdate, Seq
19

A lead is assigned to a salesper-
son

LeadAssignedAlert

Trigger on UserNamesIupA user is locked outLockedUserAlert

Event: OpportunityDueAlert,
Seq 1

An opportunity is dueOpportunityDueAlert

Event: OverBudgetAlert, Seq 1The specified account's actual
amount is above budget for the
current fiscal period. Key Value
1 is the account number, and
Key Value 2 is the percentage
over budget that triggers an alert

OverBudgetAlert

Event: IdoOnItemUpdate, Seq
18

An order line is projected to ship
late. Key Value 1 is the customer
number.

ProjectedLateShipAlert

Event: ProspectInteractionFol-
lowUpAlert, Seq 1

A follow-up is needed with a
prospect. Key Value 1 is the
prospect ID.

ProspectInteractionFollowUpAlert
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Where definedDescriptionPublication

Trigger on MO_re-
source_maint_mstIup

A scheduled maintenance task
is added for a resource. This
alert is used only with the Mold-
ing Industry Pack.

ScheduledMaintenanceAddedAlert

Event: ResourceMainte-
nanceScheduleUpdateStatus,
Seq 1

A scheduled maintenance task
has been changed from Planned
to Scheduled for a resource. This
alert is used only with the Mold-
ing Industry Pack.

ScheduledMaintenanceAlert

Event: TransactionAmountAlert,
Seq 1

The amount of a transaction for
a specified account is over the
specified amount. Key Value 1
is the account number. Key Val-
ue 2 is the amount to which
transactions should be limited.

TransactionAmountAlert

CloudSuite Industrial users can subscribe to the appropriate publications. Then, when an alert occurs
and a BOD is generated, the email addresses for all subscribers are included in the BOD.

The email address that is used in the BOD is determined by the Email Type Description field on the
Users form. If an address is specified where the Email Type Description is set to PersonID, then the
email address that is associated with the PersonID type is used. If no PersonID type is found, then the
address in the Primary Email Address field is used, as shown in this example:

If neither of these areas are populated, then a BOD is not sent.

ION attempts to match the email address from the BOD with a PersonID or primary email address that
is defined for a user in Infor Ming.le, so that it can pass along the alert. If a matching address is found,
and if the user has the appropriate Infor Ming.le permissions, the alert is displayed on the user's Alerts
panel in Infor Ming.le.

This is the general process flow:
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Configuring monitors for alerts
1 Configure CloudSuite Industrial to send alerts.

a In the Process Defaults form, set ION Pulse Interface to 1.
b For publications (alerts) that have associated event handler sequences, activate the sequences

so that the BOD will be sent when the events fire. In the Workflow Event Handler Activation
form, select the appropriate event and sequence, and select Active for this Site.

See the list of publications and their associated event handler sequences in About alerts sent
from the ERP to Infor Ming.le on page 116.

c CloudSuite Industrial users must subscribe to the appropriate publications (alerts) from the list
above, through either the Mobile Alerts form or the Publication Subscribers form.

d Set up CloudSuite Industrial users with either a PersonID email address or a primary email
address, or both. In the Email Addresses tab on the Users form, add a record to the grid where
Email Type Description is set to PersonID and an email address is assigned. You can optionally
set the Primary Email Address to another email address for the user.

See Person IDs on page 137.

2 Configure ION to process alerts from this application.
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Ensure that the Process PulseAlert BOD is included in the list of BODs that can be sent from the
CloudSuite Industrial connection point.

a In ION Desk, select Connect > Connection Points.
b Select the Infor Ming.le connection point and add Process.PulseAlert in the Documents tab if it

does not exist.

Through an internal API, ION passes the alert to Infor Ming.le as a Sync.PulseAlert BOD. See the
Infor ION Desk User Guide.

3 Configure Infor Ming.le to display alerts for this application.

Set up Infor Ming.le users with the appropriate roles to access tasks and alerts. See information
about configuring user access for tasks and alerts in the Infor ION Desk User Guide.

In addition, the value in the Infor Ming.le/IFS Person ID field must match the Workstation/Domain
ID field for the same user in CloudSuite Industrial, and theUser Name field in Infor Ming.le must
match either the PersonId email address or Primary email address for the same user in CloudSuite
Industrial. This is handled automatically if you set up users first in Infor Ming.le/IFS and then use
SecurityUserMaster BODs to populate the user records in CloudSuite Industrial, as described in
User and role BOD usage on page 137.

Configuring workflows for tasks and notifications
See the Infor ION Desk User Guide for detailed instructions on some of these steps.

1 Configure this application to send tasks and notifications.

2 Configure ION to process tasks and notifications from this application.

3 Configure Infor Ming.le to display tasks and notifications for this application.
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Chapter 11: Configuring context apps and utility apps
that are used with the ERP

On the right side of the Infor Ming.le page is a collapsible panel that hosts a series of Infor Ming.le
context and utility applications. These are mini applications that provide information at a glance.

Context apps subscribe to information published by the application frame and display relevant content
only when it is available. The information in the applications is context-sensitive, which means that the
values or content in the app depend on the current context (form or field) that is shown in the CloudSuite
Industrial application panel in Infor Ming.le.

Utility apps are lightweight applications that represent information unrelated to content in the application.
They do not communicate with the application frame and, if activated, show only when the application
is open.

Understanding business context messages
A business context message is a JSON message that is sent from a CloudSuite Industrial screen, field
or other user interface object for the purpose of establishing the current context. These messages can
be used for many contextual purposes within Infor Ming.le, as well as for drillbacks.

Business context messages are used with these context-sensitive apps when a certain CloudSuite
Industrial form is displayed:

• Determines the metrics and reports to display in the In-Context BI context app
• Determines which critical numbers to display in the Critical Numbers context app
• Determines which related files from IDM to display in the Related Information context app

For more information about the available in-context metrics and reports,critical numbers, or
context-sensitive IDM documents, see the Infor CloudSuite Industrial User Guide for Infor Operating
Service.

To find the business context message that is sent by a specific object, use the Context Viewer
application. See the Infor Ming.le online help or user guide.
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Process default settings that allow context messages to be sent
In CloudSuite Industrial, these options are set on the Process Defaults form:

• Send Context Message on Form Focus enables sending of business context messages for forms.
Default is 0 (not sent), but it is automatically set to 1 for CloudSuite Industrial through initialized
data. When set to 1, the context message "screenId": "MGCore_Formname" is sent for all forms,
where Formname is the form name, for example, “screenId”: “MGCore_UsersMaint”.
Note:  This process default is set to 1 so that CloudSuite Industrial context apps work in Infor Ming.le.

• Optional Context Message Form Prefix replaces the MGCore default prefix on all forms with a
specified prefix. For CloudSuite Industrial, the prefix is set to CSI_. So, for example, the Customers
form is sent as CSI_Customers.

Supported business context messages
Business context messages contain sets of contextual information called entities, which include
information similar to that of Infor BODs. CloudSuite Industrial can pass information about multiple
entities in one business context message.

When each CloudSuite Industrial form is displayed, a script runs that passes standard metadata in a
JSON message. The standard metadata includes the screen ID of the form and the logical ID of the
CloudSuite Industrial application. However, the message can contain additional context-sensitive
metadata that is specific to the form and current record.

This example shows an inforBusinessContext context message that was sent from the Customers
form:

{"type":"inforBusinessContext","data":{"screenId":"CSI_Customers","enti►
ties":[{"entityType":"InforAccountingEntity","id1":"DALS"},{"entity►
Type":"InforShipToPartyMaster","id1":"4851","id2":"0","accountingEnti►
ty":"DALS","drillbackURL":"?LogicalId=lid://infor.syteline.dals&page=for►
monly&form=Customers(FILTER(CustNum%3D%27%20%20%20%20%2013%27%20AND%20Cust►
Seq%3D0)SETVARVALUES(InitialCommand%3DRefresh))","bodRefer►
ence":{"noun":"BillToPartyMaster","documentId":"4851","accountingEnti►
ty":"DALS","logicalId":"lid://infor.syteline.dals"}},{"entityType":"Infor►
CustomerPartyMaster","id1":"4851","name":"Brand Central Dept Store","ac►
countingEntity":"DALS"}]}}

The message informs context apps that the Customers form is currently displaying a record for the
Brand Central Dept Store, which has the customer ID 4851 and the Ship To address ID 0, in the
accounting entity DALS. The message contains one or more business entities, or collections of
information, associated with the current record. The entity information can include a relative URL that
can be used to drill back into the application and display the form and record. It also can include a BOD
reference that maps from the current entity in the user interface to a corresponding BOD noun.

Any context apps that are associated with CloudSuite Industrial receive all of the information in this
message. Each context app searches its data to determine whether it has contextual information to
display that is related to information in this message.
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For example, the In-Context BI (ICBI) context app uses the screen ID of CSI_Customers and the
customer ID 4851 to determine that it should display an Accounts Receivable Aging report for Brand
Central Dept Store. The Related Information context app uses the entity type, or context, and its
parameters from the message to determine if there are any documents related to that context in its
database. If so, the documents are listed in the app and can be opened. If you drag and drop files into
the Related Information app pane while this form and record are displayed in CloudSuite Industrial,
the files are automatically linked in Infor Document Management to each of the entity types (contexts)
listed in the context message.

Context and utility apps that work with the ERP
These standard context and utility apps are available for use with CloudSuite Industrial. For information
about how to use the standard apps, see the Infor Ming.le online help or user guide.

• Alerts
• Context Viewer
• Paparazzi
• Posts
• Tasks

These application-specific context apps are also available:

• Critical Number context app

Critical numbers are key performance indicators, or KPIs, that are specific to CloudSuite Industrial
data and transactions. Users must be authorized to view critical numbers, which are associated
with certain CloudSuite Industrial forms. See Authorizing users to display critical numbers in widgets
or the Critical Numbers app on page 124.

• In-context BI for CloudSuite context app

Use this app to view business critical metrics and reports in an adjacent pane while certain forms
are displayed. For example, when you are viewing a customer record on the Customers form, you
can see metrics specific to that customer.

• Related Information

This app can display context-sensitive files that are stored in Infor Document Management but that
are associated with specific CloudSuite records. You can set up workflows in CloudSuite Industrial
to handle this. See Activating the IDM workflows in the ERP on page 71.

For information about how to use the application-specific apps, see the Infor CloudSuite Industrial User
Guide for Infor Operating Service.

All of the apps are initially disabled. When the apps are enabled for CloudSuite Industrial, their content
is displayed in small app panes to the right of your application.

Infor CloudSuite Industrial Configuration Guide - Cloud Edition | 123DRAFT
 

Configuring context apps and utility apps that are used with the ERP



Enabling a context or utility app for the ERP
To enable one or more of the context or utility apps to work with CloudSuite Industrial:

1 From the User Menu, select Admin Settings.
2 In the Manage Applications tab, double-click to select your application.
3 In the Manage Context/Utility Apps tab, select the app that you want to enable.
4 in the Permissions tab for that app, either select Grant access to all users or click Add new users

and/or IFS security roles to specify certain users or roles in CloudSuite Industrial that can access
this context app.

5 In the Applications tab for that app, select your application and enable it for the app.
6 Save your changes.

In order to see the changes, you might need to sign out of the application and Infor Ming.le. Close your
browser and reopen it.

Authorizing users to display critical numbers in widgets or the Critical
Numbers app
To enable users to view and select critical numbers for display in widgets, home pages or the Critical
Numbers context app, you must set up the appropriate authorizations in CloudSuite Industrial.

1 Enable the Critical Numbers context app as described in Enabling a context or utility app for the
ERP on page 124

2 In CloudSuite Industrial, open the Critical Number Users form.

3 Select a user record.
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4 On the Categories tab, specify user authorizations for a critical number category, or on the
Permissions tab, specify user authorizations for specific critical numbers.

5 Save your changes.

6 Ask the user to log out of CloudSuite Industrial and then log in again, so the changes can take effect.

7 Verify that users can view critical numbers that they are authorized to view in the Critical Numbers
context app.

How critical numbers are displayed in the Critical Numbers app
When the user opens a CloudSuite Industrial form in the Infor Ming.le portal, the form sends a JSON
inforBusinessContext message that includes its entity type. The entity type is the BOD sent when the
content of the form is update. For example, the Customers form has the entity type
InforCustomerPartyMaster.

These actions are taken when the business context message is received:

• Check the entity type in the business context message and find the related category of forms.
• Determine which critical numbers (if any) the user has selected within that category on the User

Critical Number Selection form.
• Determine how many instances of the Critical Number app the user has created in Infor OS.
• Load the selected critical numbers into multiple instances of the Display Critical Number form.

Each instance is displayed in a Critical Number pane.

The sequence of the critical number determines which critical numbers are shown. For example, if the
user selected five critical numbers for a category, but only added three instances of the Critical Number
app, then only the first three (sequential) critical numbers are displayed.
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Chapter 12: Verifying Homepages for the ERP

Homepages are a flexible and configurable way to present information and activities to users.
Administrators can build pages for various groups of users, roles, departments, or business functions.
You can select from the library of available Infor widgets or build your own.

The predefined Homepages and widgets for CloudSuite Industrial were imported automatically when
the application was added to Infor Ming.le.

In this section, you will verify that they are working for your users.

For general Homepages administration tasks, see the Infor Ming.le online help.

For information about using the homepages and widgets, see the Infor CloudSuite Industrial User
Guide for Infor Operating Service.

Verifying the homepage and widget content
1 Log into Infor Ming.le as a non-administrative user who has access to both Infor Ming.le and

CloudSuite Industrial.

2 Open the Homepages application.

3 Add a Homepage:

a Click Create New Page.
b Specify a title and description for the page and click Create.
c Click the ellipsis (…) button and select Page Catalog.
d Select one of the predefined Homepages and click Add Page.

You must be authorized in CloudSuite Industrial to open that “home page” form.

These are the groups/roles associated with each home page:
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Security role/groupHomepage name

PurchasingBuyer Home

Mobile ControllerController Home

Order EntryCustomer Service Home

Mobile ExecutiveExecutive Home

InventoryInventory Control Home

Shop Floor ControlProduction Planner Home

ProjectsProject Manager Home

Order EntrySalesperson Home

e Close the catalog to view your new Homepage.

4 Add a widget:

a Click the ellipsis (…) button and select Widget Catalog.
b Select Categories > Application.
c In the Refine By filter, select Infor CloudSuite. You should see the CloudSuite Industrial

widget.
d Click + (Add Widget).
e Close the catalog to view your new widget.
f Configure the widget.

5 Add a critical numbers widget, and configure it. Ensure that you can view critical numbers that you
are authorized to view in this widget.

You must be authorized in CloudSuite Industrial to view the critical numbers.

6 Drill down to CloudSuite Industrial forms from the appropriate widgets.

Modifying permissions for standard pages
The CloudSuite Industrial Home pages are included in the Standard Pages tab.

If you want only a specific group of users to access the standard page, you can restrict the standard
page to a security role in Infor Ming.le.

To view or change the permissions that are assigned to a page:

1 Open the Homepages application.

2 Click the ellipses (…) button and select Advanced > Administration.

3 On the Standard Pages tab, select the home page you want to edit.

4 Select Actions > Edit Permissions.

Note:  Permissions can be set at the group, role or user level.
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Chapter 13: Configuring BI and Analytics content for
the ERP

Draft Comments Update with Birst info when available.

To configure BI and Analytics content for the ERP, you must complete these tasks:

• Configure access to BI.
• Configure In-Context BI content.
• Configure BI Dashboards.
• Configure BI widgets and homepages.
• Configure BI reports.

See the Infor BI documentation for information about performing the steps in the last three bullets.

Configuring access to BI
In order to use Analytics features such as In-Context BI or Analytics widgets and homepages in Infor
Ming.le, you must set up roles and permissions in both Infor Ming.le and Analytics.

Setting up roles and permissions in Analytics

See the Infor CloudSuite Industrial Analytics MT Cloud User Guide and the Infor BI documentation.

Setting up roles and permissions for Analytics products in Infor Ming.le

See the Infor Ming.le online help or user guide for information about how to set up roles and associate
them with an application.

Configuring In-Context BI content
You can display CloudSuite Industrial In-Context BI metrics and reports in Infor Ming.le. To display the
metrics and reports with the appropriate forms:
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1 Enable the In-Context BI for CloudSuite Industrial context app and set up authorizations for it.

See Enabling a context or utility app for the ERP on page 124.

2 In Analytics, add all CloudSuite Industrial users, as defined in Infor Ming.le (IFS), to the ReportViewer
group:

a From Infor Ming.le, open the BI Application Manager.
b Click Dashboards and select User and Permission Management > User and User Groups.

c If the In-Context BI context app has been enabled, it is listed in the Application field. Select
In-Context BI and select ViewRole.

d Click the edit icon on the left to select the users or user groups who should have view permissions
for In-Context BI.

For information about using In-Context BI content for your application within Infor Ming.le, see the Infor
CloudSuite Industrial User Guide for Infor Operating Service.
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Chapter 14: Configuring and integrating optional
applications in the CloudSuite

You must configure some optional products in the CloudSuite to work with the components of Infor OS
(ION, Infor Ming.le, Infor Document Management, or BI).

Some products also require additional integration steps to work with the ERP.

Integrating with Infor CPQ
If Infor Configure Price Quote (Infor CPQ, formerly known as Product Configuration Management) is
included in the CloudSuite, the Infor Cloud team adds the application to Infor Ming.le and configures
the point-to-point connection to the ERP.

During post-provisioning, the configuration parameters were set up in the Inventory Parameters form,
some sample ruleset data was added to Design Studio, and sample content was added to the Infor
CPQ Workbench app. See Configuring CPQ on page 56.

To complete the integration between the ERP and Infor CPQ, see these documents:

• Setting Up a Configuration Interface for an Item or Job” in the ERP online help
• Infor SyteLine Integration Guide for Infor Product Configuration Management

Integrating with Infor CRM
Infor CRM is currently a hybrid integration; that is, CRM is either installed on-premises or in a single
tenant cloud, and then communicates with ION through the Enterprise Connector.

1 To install the Enterprise Connector and set up the CRM connection point for ION in the Cloud, see
these guides:

• Infor CRM Back Office Extension Configuration Guide for Infor ION
• Infor CRM Implementation Guide

2 If Infor CRM is included in the CloudSuite, you, Infor Consulting, or the business partner configure
the BODs and document flow during Post Provisioning. See these sections:

• Configuring BODs for the Infor CRM integration with Infor Ming.le on page 39
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• Creating the CSI > CRM > CSI document flow on page 86

3 To complete the integration between CRM and the ERP, see the Infor CloudSuite Industrial Integration
Guide for Infor CRM - Cloud Edition.

Integrating with Infor EAM
1 If EAM is included in the CloudSuite, you, Infor Consulting, or the business partner must configure

the BODs and document flow during Post Provisioning. See these sections:

• Configuring BODs for the Infor EAM connection point on page 85
• Creating the CSI > EAM > CSI document flow on page 90

2 To set up additional EAM configuration with Infor Ming.le and ION, see these guides:

• Infor EAM Configuration Guide for Infor Ming.le: See the sections on loading EAM in-context BI
content and importing EAM drillbacks. Other sections are mainly intended for the on-premises
version.

• Infor EAM Configuration Guide for Infor ION: See the sections on Configuring Databridge Partners,
Configuring EAM, Sending the initial data load, and Infor EAM BOD dependencies. Other sections
are mainly intended for the on-premises version.

3 To complete the integration between EAM and the ERP, see theInfor CloudSuite Industrial Integration
Guide for Infor EAM – Cloud Edition.

Integrating with Infor Expense Management
1 If Infor Expense Management is included in the CloudSuite, you, Infor Consulting, or the business

partner must configure the BODs and document flow during Post Provisioning. See these sections:

• Configuring BODs for the Infor Expense Management connection point on page 85
• Creating the CSI > XM > CSI document flow on page 91

2 To set up additional Infor XM configuration with Infor Ming.le and ION, see these guides:

• Infor Expense Management Configuration Guide for Infor ION
• Infor Expense Managementt Configuration Guide for Infor Ming.le

3 To complete the integration between Infor XM and the ERP, see the Infor CloudSuite Industrial
Integration Guide for Infor Expense Management – Cloud Edition.
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Integrating with Infor Factory Track
If Infor Factory Track is included in the CloudSuite, the Infor Ming.le connection and the point-to-point
connection to CloudSuite Industrial are configured by the Infor Cloud team. That team also creates
one administrative user for Factory Track in Infor Ming.le and Factory Track.

1 Because Infor Ming.le is the system of record for users, you must set up users for each CloudSuite
application in Infor Ming.le. Factory Track does not yet use BODs to coordinate user accounts with
the accounts that are created in Infor Ming.le. Instead, you must manually link an Infor Ming.le
account to a user in that application:

a In the Infor Ming.le Portal, open the User Management page.
b Create an Infor Ming.le user account.

Note the Email address and IFS Person ID (GUID). The GUID is the link between the Infor Ming.le
and Factory Track accounts that allows SSO/SLO to function correctly.

c In the Infor Ming.le Portal, open the Factory Track application.
d If needed, select the appropriate configuration
e Open the Users form.
f Create a user account with the same user name (email address) that was used in step b.
g Save your changes.
h Add the IFS Person ID from step b into the Workstation Domain/ID field.
i Set the required license modules for the user.
j Set the required groups (roles) for the user.
k Save your changes.

2 To complete the integration between Factory Track and CloudSuite Industrial, see the Infor Factory
Track for SL Implementation Guide.

Integrating with Microsoft Office
Before using the integrated Office features with CloudSuite Industrial, users must download the plug-ins
for Excel, Word, and Projects from the Infor Xtreme Download Center to their local devices. The Trust
setting must be enabled for Excel.

See the Infor CloudSuite Industrial MicrosoftOffice Integration User Guide.

Configuring add-in applications
Add-in applications are built into the ERP application. However, some of the add-ins require additional
configuration. See these documents:
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ReferenceAdd-in module

Help topic: “APS: Initial Setup Steps”APS

Automotive Industry Pack help topics and user
guide

Automotive Industry Pack

Infor CloudSuite Industrial Credit Card Interface
Configuration Guide

Help topic: “Setting Up the Credit Card Interface”

Credit Card Interface module

Help topic: “Configuring Employee Self Service”Employee Self Service

Infor CloudSuite Industrial Forecasting User GuideForecasting

Help topic: “Setting Up Mobile Access”Mobile

Molding Industry Pack help topics and user guideMolding Industry Pack

Infor CloudSuite Industrial Portal Administration
Guide - Cloud Edition

Portals

Printing Industry Pack help topics and user guidePrinting Industry Pack

Process user guideProcess Industry Pack

QCS help topics and user guideQuality (QCS)

Help topic: “Setting up Service Parameters”Service

Infor CloudSuite Industrial SytePlan Implementa-
tion and User Guide

SytePlan

Infor CloudSuite Industrial Tax System Interface
Configuration Guide

Help topic: “Setting Up a Tax Interface”

Tax System Interface
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Appendix A: Useful URLs

The Infor Cloud team provided you with working URLs to the products in your CloudSuite. These
examples are provided for your convenience.

Standard URLs

Infor Ming.le Web:

https://<Mingle_Prod_Domain>/<TenantID>

Example: https://mingle-portal.inforcloudsuite.com/TENANT_Dem

Web Client:

https://<App_Prod_Domain>/WSWebClientM/default.aspx?ConfigGroup=<ConfigGroup
Name>

Example: https://csi901.inforcloudsuite.com/WSWebClientM/default.aspx?Config
Group=TENANT_Dem

Mobile Client:

https://<App_Prod_Domain>/WSWebClientM/mobile.aspx?ConfigGroup=<ConfigGroup
Name>&page=formonly

Example: https://csi901.inforcloudsuite.com/WSWebClientM/mobile.aspx?Config
Group=TENANT_Dem &page=formonly

IDO Web Service Connection:

https://<App_Prod_Domain>/IDORequestService/IDOWebService.asmx?Config
Group=<ConfigGroupName>

Example: https://csi901.inforcloudsuite.com/IDORequestService/IDOWebService.as
mx?ConfigGroup=TENANT_Dem

ERP specific URLs

Click Once Client:

https://<ERP_Prod_Domain>/slclientdeploy/syteline.application?Config
Group=<ConfigGroupName>

Example: https://csi901.inforcloudsuite.com/slclientdeploy/syteline.applica
tion?configgroup=TENANT_Dem
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Production Tax Interface Web Service:

https://<ERP_Prod_Domain>/TaxIntegrationService/SSSAvataxSvc.asmx?Config
Group=<ConfigGroupName>

Example: https://csi901.inforcloudsuite.com/TaxIntegrationService/SSSA
vataxSvc.asmx?ConfigGroup=TENANT_Dem

Development Tax Interface Web Service:

https://<ERP_Prod_Domain>/TaxIntegrationServiceDev/SSSAvataxSvc.asmx?Config
Group=<ConfigGroupName>

Example: https://csi901.inforcloudsuite.com/TaxIntegrationServiceDev/SSSA
vataxSvc.asmx?ConfigGroup=TENANT_Dem

Credit Card Interface Web Service:

https://<ERP_Prod_Domain>/CreditCardIntegrationService/

Example: https://csi901.inforcloudsuite.com/CreditCardIntegrationService/

Employee Self Service:

https://<ERP_Prod_Domain>/WSWebClientM/default.aspx?page=FormOnly&noti
tile=1&ConfigGroup=<TENANTID>&form=EmployeeSelfServiceHome.ess

Example: https://csi901.inforcloudsuite.com/WSWebClientM/default.aspx?page=For
mOnly&notitile=1&ConfigGroup=TENANT_Dem&form=EmployeeSelfServiceHome.ess

Online Service Mobile:

https://<CSI Prod Domain>/WSWebClientM/default.aspx?page=FormOnly&noti
tile=1&ConfigGroup=<TENANTID>&form=HomePage_Service.mobi

Example: https://csi901.inforcloudsuite.com/WSWebClientM/default.aspx?page=For
mOnly&notitile=1&ConfigGroup=TENANT_DEM&form=HomePage_Service.mobi

Factory Track standard URLs

Click Once Client:

https://<FTK_Prod_Domain>/clientdeploy/factorytrack.application?Config
Group=<ConfigGroupName>

Example: https://ft601.inforcloudsuite.com/clientdeploy/factorytrack.applica
tion?ConfigGroup=TENANT_Dem

Light Client:

https://<FTK_Prod_Domain>/WSWebClientM/Default.aspx?page=light&form=ICWMMain
Menu.mobi&ConfigGroup=<ConfigGroupName>

Example: https://ft601.inforcloudsuite.com/WSWebClientM/Default.as
px?page=light&form=ICWMMainMenu.mobi&ConfigGroup=TENANT_Dem

Shop Floor URL:
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https://<FTK_Prod_Domain>/WSWebClientM/Default.aspx?page=formonly&form=IC
SLWorkCenterNavigationHome.ts&&ConfigGroup=<ConfigGroupName>

Example: https://ft601.inforcloudsuite.com/WSWebClientM/Default.aspx?page=for
monly&form=ICSLWorkCenterNavigationHome.ts&&ConfigGroup=TENANT_Dem

Warehouse Mobility URL:

https://<FTK_Prod_Domain>/WSWebClientM/Mobile.aspx?page=light&form=ICWMMain
Menu.mobi&&ConfigGroup=<ConfigGroupName>

Example: https://ft601.inforcloudsuite.com/WSWebClientM/Mobile.as
px?page=light&form=ICWMMainMenu.mobi&&ConfigGroup=TENANT_Dem
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Appendix B: User and role BOD usage

This appendix provides detailed information about how the security BODs are used between CloudSuite
Industrial and Infor Ming.le.

BODs that send roles (authorization groups) from the ERP
to Infor Ming.le
Some roles from CloudSuite Industrial are preconfigured in Infor Ming.le when the application is added
in Infor Ming.le.

When you create or edit an authorization group in CloudSuite Industrial, a Sync.SecurityRoleMaster
BOD is generated. This BOD is defined at the tenant level. The information from this BOD is used in
Infor Ming.le to automatically create a matching security role.

If you create a security role in Infor Ming.le that does not exist in CloudSuite Industrial, you must
manually create a matching group in CloudSuite Industrial. Remember that CloudSuite Industrial is the
system of record for roles/groups.

If you delete a role in either CloudSuite Industrial or Infor Ming.le, you must also delete the group or
role in the other application.

Person IDs
Any CloudSuite Industrial users who plan to use Infor Ming.le or other Infor OS components must be
set up as users in Infor Ming.le, and the user’s Person ID must be synchronized between Infor Ming.le
and CloudSuite Industrial.

Person IDs in Infor Ming.le
The user details page in Infor Ming.le includes an ERP Person ID tab. The ERP Person ID tab is
populated if CloudSuite Industrial publishes the Sync Person BOD. The ERP Person ID is used as the
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identifier of the user in the ERP application, and allows you to link the Infor Ming.le user to the ERP
application user. The ERP Person ID tab shows all ERP person IDs that are associated with this Infor
Ming.le user.

The IFS Person ID is used as the user identifier in ION, which then links the Infor Ming.le user with the
ION BODs. By default, the IFS Person ID is set to the User Principal Name (UPN) of the user. UPN is
an AD FS concept.

The IFS Globally Unique Identifier (GUID) is the same as the UPN.

Sending the Person ID from the ERP to Infor Ming.le
When certain information is manually added or updated in CloudSuite Industrial for a user, a
Process.SecurityUserMaster BOD is published by CloudSuite Industrial.

The Workstation/Domain ID field on the Users form in CloudSuite Industrial contains the Person ID
for a user. This value should not be changed. It is possible to update this value in CloudSuite Industrial
and then manually publish the Process.SecurityUserMaster BOD to Infor Ming.le; however, Infor Ming.le
is the system of record for user information, so you should only maintain the Person ID value In Infor
Ming.le.

BODs that send user information from Infor Ming.le to the
ERP
When you add a user in the Infor Ming.le portal, a SecurityUserMaster BOD is sent through ION to
your application at the specified intervals, where a matching user record is created or updated. This
BOD contains the user name, login, creation date, status, description, email address, and the roles,
or groups, to which the user is assigned.

When CloudSuite Industrial receives the BOD, these actions occur:

• For a new user that does not exist in CloudSuite Industrial:
• A new user record is added.
• The Workstation Domain/ID field is populated with a row pointer value that should not be

changed.
• The group authorizations for that user are added.
• A primary email type description is added that contains the user’s email address.
• The user’s First Name and Last Name values from Infor Ming.le are combined into the CloudSuite

Industrial User Description field, separated by a space.

• For an existing user in CloudSuite Industrial, if the existing user ID has not changed:
• The existing user group authorizations are deleted.
• The user status, user descriptions, primary email address, and user group authorizations are

updated.
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• For an existing user in CloudSuite Industrial, if the existing user ID has changed:
• The record for the user with the matching Workstation Login is set to a status of disabled, and

the Workstation Login for the user is cleared.
• The Workstation Domain/ID field is populated with a row pointer value that should not be

changed.
• A new user record is created, copying the user information from the disabled record. Any existing

user group authorizations in CloudSuite Industrial are deleted, and then the groups from the BOD
are added. The status, email, and description are updated if they have changed.

• An Acknowledge SecurityUserMaster BOD is sent back to Infor Ming.le.

BODs that send user information from the ERP to Infor
Ming.le
When any of this information is manually added or updated in CloudSuite Industrial for a user, a
Process.SecurityUserMaster BOD is published by CloudSuite Industrial:

• User login status
• User description: A value is required in this field if you are passing user information from CloudSuite

Industrial to Infor Ming.le through the Process SecurityUserMaster BOD. The field must contain
values separated by a space. The first value becomes the First Name in Infor Ming.le. Everything
after the space becomes the Last Name in Infor Ming.le. For example, if the CloudSuite Industrial
User Description is Tom Van Winkle, Tom is the First Name and Van Winkle is the Last Name in
Infor Ming.le.

• Workstation login
• Primary email address: A value is required in this field if you are passing user information from

CloudSuite Industrial to Infor Ming.le through the Process SecurityUserMaster BOD.
• Group authorizations

However, if the user information was changed in CloudSuite Industrial because of an incoming
Sync.SecurityUserMaster BOD from Infor Ming.le, the Process.SecurityUserMaster BOD is not published.

CloudSuite Portals users

Draft Comments Issue 229711
If a new user is created in CloudSuite Industrial based on a request from the CloudSuite vendor or
customer portals, the BOD is not sent to Infor Ming.le.
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Appendix C: Troubleshooting

This section describes actions that you can perform to solve Infor OS integration issues.

Data is not flowing properly
Cause: A problem is preventing the flow of BOD data to ION.

Solution: After you complete the configuration setup, if BOD data is not flowing to ION, use ION OneView
to identify the problem.

ION OneView can be found in the menu for ION Desk. You can perform these actions in ION OneView:

• Track business documents from a single consolidated view; search for documents using different
search criteria.

• View all ION components that were triggered by the incoming document: Connection Points;
document flow filters and content-based routing; mappings; ION engines for example, Monitor,
Workflow, and Pulse; monitors; activation policies and workflows.

• View more details about these ION components:
• Detailed properties for each ION component
• List of events that were logged by each ION component while processing the message
• Drilldown views that are used to display the appropriate management pages for the selected

ION component
• Visibility and correlation of the different messages sent or generated:
• Original BOD messages that triggered the whole list of components displayed; Confirm BOD

messages that were generated due to any error while processing the Original BOD message.
Mapped/Updated BOD messages that were created during the processing of the Original BOD
message

• View content of BOD messages. This information is only available to authorized users, based
on the roles and permissions that are configured.

For more information, see the section on ION OneView in the Infor ION Desk User Guide - Cloud
Edition.

To avoid business discrepancies between this application and integrated applications, correct any
errors as soon possible.
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BOD information needs to be purged
Information from every inbound BOD, including sequencing information, is collected in a table in the
CloudSuite Industrial application. This data constantly builds up and, over time, could cause performance
issues. For this reason, system administrators should periodically use the Purge BOD Information
form to purge information from that table. You can set up a background task to perform this function
automatically

You can also use the Replication Document Inbox/Outbox Purge Utility to clear out older BODs
from the Replication Document Inbox and Replication Document Outbox.

ERP help is not working
Verify that the user’s web browser has popup blockers turned off. Clear the browser cache, restart
Infor Ming.le and try again.
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Appendix D: Business events that generate outbound
BODs

This table shows the events, which are user actions in CloudSuite Industrial that generate an outbound
BOD from CloudSuite Industrial:

User action to generate the BODNounVerb

Run the Replication Document Manual Request
Utility with AccountingBookDefinition selected.
This should be done once per site.

AccountingBookDefinitionProcess

Run the Replication Document Manual Request
Utility with AccountingChart selected. This should
be done once per site, after the Chart of Accounts
is set up at the site.

AccountingChartSync

Run the Replication Document Manual Request
Utility with AccountingEntity selected. This should
be done once per site, after the tenant ID is set
up at the site.

AccountingEntitySync

Ship the order, either manually with the Transfer
Order Ship form, or automatically in response to
a received Sync Shipment BOD.

AdvanceShipNoticeProcess

Acknowledge the receipt of a BillofMaterials from
an external application.

BillofMaterialsAcknowledge

Indicate that changes have been made in the ap-
plication after receipt of a Process BillofMaterials
from an external application

BillofMaterialsSync

Acknowledge the receipt of a BillToPartyMaster
from an external application.

BillToPartyMasterAcknowledge

Change any information on the Customers form.

Change any information on the Ship Tos form.

BillToPartyMasterSync

Add or update a shift calendar in Scheduling
Shifts.

Add a holiday. This creates a BOD that indicates
all resources are busy on that day.

CalendarSync
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User action to generate the BODNounVerb

Select the Physically Shipped check box on the
Special tab of the Delivery Orders form.

CarrierRouteSync

Create or update an account record in the Chart
of Accounts form. Statistical and allocation ac-
counts are not included.

ChartOfAccountsSync

Acknowledge the receipt of a CodeDefinition from
an external application

CodeDefinitionAcknowledge

* Add an Education Major

* Add an External Expense Type

* Add an Indirect Labor Code

* Add an Inventory Adjustment Reason Code

* Add or update an ISO U/M on the Unit of Mea-
sure Codes form

* Add an Item Category

* Add an Obsolete Slow Moving Reason Code

* Add an Opportunity Source

* Add an Opportunity Stage

* Add a Payment Type

* Add a Position

* Add a Price Code

* Add a Product Code

* Add a Project Cost Code

* Add a Province/State

* Add a Shift ID on the Scheduling Shifts form

* Add a Ship Via Code

* Add a Skill

* Add a Tax Code of type Exempt

* Add a Tax Jurisdiction

* Add a Territory

* Add a Training Course

* Add a unit code on the Unit Code 1 - 4 forms

* Add a Work Code

* Add a Work Experience

BODS for some other codes, such as language
IDs and cost methods, are automatically generated
when the Replication Document Manual Request
Utility is run.

CodeDefinitionSync
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User action to generate the BODNounVerb

Insert or modify a Shift ID (creates a BOD for as-
sociated resources)

ConstrainedResourceProcess

Acknowledge the receipt of a ContactMaster from
an external application

ContactMasterAcknowledge

* Add or change a Contact

* Create a Customer Sales Contact Cross-Refer-
ence

ContactMasterSync

* Add or update Customer Order header

* Add or update Customer Order Blanket Line

ContractSync

Create a Bank Reconciliations record for a vendor
payment, employee payment, or customer pay-
ment

CreditTransferSync

Add or update a Currency RateCurrencyExchangeRateMasterSync

Acknowledge the receipt of a CustomerPartyMas-
ter from an external application

CustomerPartyMasterAcknowledge

* Change any information on the Customers form,
Ship Tos form, or Customer Sales Contact Cross
References form

* Add a prospect on the Prospects form to send
this BOD with a status of “Pending”

CustomerPartyMasterSync

* Print the RMA Order Verification Report

* Change the status of an RMA

CustomerReturnSync

Post a direct debit transaction from a customer on
the A/R Direct Debit Posting form.

DebitTransferSync

Acknowledge the receipt of an expense report.ExpenseReportAcknowledge

* Change any information on the Accounting Peri-
ods form

* Run the change Reports To Entity utility

FinancialCalendarSync
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User action to generate the BODNounVerb

* Perform Quantity Adjustment

* Perform Miscellaneous Receipt or Miscellaneous
Issue

* Perform Cycle Count Posting - one BOD is gen-
erated for each combination of item, warehouse,
and location where the quantity on hand has
changed

* Perform Physical Inventory Posting - one BOD
is generated for each combination of item, ware-
house, and location where the quantity on hand
has changed

InventoryAdjustmentSync

* Run the Cycle Count Posting utility

* Run the Physical Inventory Posting utility

One InventoryCount BOD is sent for each
item/warehouse combination

InventoryCountSync

* Print and post an invoice through the Consolidat-
ed Invoicing form

* Post an invoice through the Invoice Posting (A/R)
form

Note: The Invoice BOD publishes one line for ev-
ery order line included in the Invoice. When Line
Summarization is turned on in Consolidated Invoic-
ing, the summary invoice lines are not published;
instead, each customer order line will be published
as a line in the Invoice BOD.

InvoiceSync

Acknowledge the receipt of a Process ItemMaster
from an external application.

ItemMasterAcknowledge

* Create a new item on the Items form

* Make a change to these fields on the Items form:
Item, Description, ABC Code, Commodity, Cost
Method, Material Status, Reason, Backflush, Last
Change, U/M, Unit Cost, S/N Track, Lot Track,
Source, Order Minimum, Order Maximum, Alter-
nate Item

* Add or change an item description on the Multi-
Lingual Items form

ItemMasterSync

* Print EU Sales List Report

* Print SSD Transaction Listing Report

LCLTradeStatisticsSync

* Create a new Warehouse

* Update General Parameters form (creates a
Location BOD with the site as the location)

LocationSync
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User action to generate the BODNounVerb

* Create or update a record on the Opportunities,
Customer Orders, or Opportunity Tasks form

OpportunitySync

* Post a voucher or an Adjustment through the
A/P Voucher Posting form

* Post a payment from any of these forms: A/P
Check Printing/Posting, A/P Draft Printing/Posting,
A/P EFT Posting, A/P Wire Posting

PayableTrackerSync

* Post a voucher through the A/P Voucher Posting
form

* Post a payment from any of these forms: A/P
Check Printing/Posting, A/P Draft Printing/Posting,
A/P EFT Posting, A/P Wire Posting

* Set or release a Hold status on a voucher

PayableTransactionSync

Acknowledge the receipt of a PayFromPartyMaster
from an external application

PayFromPartyMasterAcknowledge

* Change any information on the Customers form

* Change any information on the Ship Tos form

PayFromPartyMasterSync

* Add or update information about a salesperson
or sales manager on the Salespersons form

* Update information related to a salesperson on
the Employees form (for employee sales people)
or Vendors form (for outside sales people)

PersonSync

* Add or update information on these forms: Em-
ployee, Employee Skills, Employee Cert/License,
Employee Education, Employee Training Courses,
Employee Work Experience, or Employee Position

PersonnelSync

Acknowledge the receipt of a Planning Schedule
from an external application.

PlanningScheduleAcknowledge

Acknowledge the receipt of a ProductionOrder
from an external application

ProductionOrderAcknowledge
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User action to generate the BODNounVerb

* Applied filters on the Background Task generate
this BOD for a firm job that is scheduled for the
first time. This does not apply to jobs that have
just been processed by the TriggerProduc-
tionOrderBGSyncSp Background task. You can
add subsequent filters to reduce the number of
BODs triggered by this task. Without filtering, after
every scheduling or planning function a significant
number of BODs could be created.

* Change the status of a job or production sched-
ule.

* Change the Qty Released of a job or production
schedule when the status is Released.

Notes: Creating a job generates this BOD, but
changes to a firm job do not generate this BOD.
This BOD must be included in an initial load of
ProductionOrder data.

ProductionOrderSync

Create a Project or change the project status.ProjectMasterSync

One or more of these publications is triggered by
a system event: CustomerCreditHoldAlert; Cus-
tomerInteractionFollowupAlert CustomerOrder-
CreditHoldAlert; CustomerShipmentAlert; DC-
ShopFloorTransactionErrorAlert; JobMaterial-
CostAlert; JobOperationHoursAlert; JobOverPro-
ductionAlert; JobProjectedLateForCustomerAlert;
LateOrderShippingAlert;LeadAssignedAlert;
LockedUserAlert; OpportunityDueAlert; OverBud-
getAlert; ProjectedLateShipAlert; ProspectInterac-
tionFollowupAlert; ScheduledMainte-
nanceAddedAlert; ScheduledMaintenanceAlert;
TransactionAmountAlert

PulseAlertProcess

* Print the Purchase Order Report

* Print a Change Order Report

PurchaseOrderSync

* Print the Purchase Order Report

* Print the Builder Purchase Order Report

* Change the Purchase Order status to Complete

* Print a Change Order Report

QuoteAcknowledge

Acknowledge the receipt of a Quote from an exter-
nal application.

QuoteSync

Change the Estimate status to QuotedReceivableTrackerSync
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User action to generate the BODNounVerb

* Generate an invoice for customers with an 'Open
Item' balance method. The status is set as Open.

* Generate a debit memo/finance charge for cus-
tomers with an 'Open Item' balance method. The
status is set as Open.

* Make a payment and apply it to an invoice for
customers with an 'Open Items' balance method.
The status changes to Paid.

* Generate a credit memo and attach it to an in-
voice for customers with an 'Open Item' balance
method. This changes the status to Paid.

(For bullet points 2, 3, and 4: If all or part of the
debit memo/finance charge, payment, or credit
memo is left unapplied, a second BOD is generat-
ed. Similar transactions are grouped and shown
under an invoice number '0' with a status of Unap-
plied Cash.)* Create an invoice, payment, credit
memo, debit memo or finance charge transaction
for a customer with a 'Balance Forward' balance
method. The system maintains one balance under
invoice number '0'. Its status is set as follows: for
a debit balance, the status is set as Paid; for a
credit balance, the status is set as UnappliedCash.

ReceivableTransactionSync

* Perform material transactions that add inventory
tied to these types of orders: Project, Job, Cus-
tomer Order (with a negative quantity), Purchase
Order, RMA, Production Order or Transfer Order
that cause a material transaction to occur

* Run the Multi-Site Quantity Move utility

ReceiveDeliverySync

* Post a payment from any of these forms: A/P
Check Printing/Posting, A/P Draft Printing/Posting,
A/P EFT Posting, A/P Wire Posting, or Print/Post
Payroll Checks

RemittanceAdviceSync

* Add or update Vendor information

* Update the vendor's address information

* Update Bank Address information

RemitToPartyMasterSync

Acknowledge receipt of a Requisition from an ex-
ternal application

RequisitionAcknowledge
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User action to generate the BODNounVerb

* Print the requisition on either the Purchase
Requisition Report or the PO Requisition Report
forms

* Convert a requisition to a purchase order

* Convert additional items on an existing requisi-
tion (in this case, another BOD is created, replac-
ing the original BOD)

RequisitionSync

Acknowledge the receipt of a SalesOrder from an
external application

SalesOrderAcknowledge

* Print the Customer Order Verification Report

* Change order header status to Completed

SalesOrderSync

Add, delete or change the objects that a group or
user can access.

SecurityPermissionMasterSync

Add or delete a Group Authorization or change
the group description.

SecurityRoleMasterSync

Acknowledge the receipt of a SecurityUserMaster
from an external application.

SecurityUserMasterAcknowledge

Add or change the user status, user description
or workstation login.

SecurityUserMasterProcess

Add or update Service Order or Service Order
Operations or Lines.

ServiceOrderSync

* Add or update Vendor information

* Update the vendor's address information

* Update Bank Address information

ShipFromPartyMasterSync

* For customer orders or lines that are assigned
to the local site and that are assigned to an exter-
nal controlled warehouse, print the Order Verifi-
cation Report.

* For transfer orders or lines where the Ship From
site is the local site and the Ship From warehouse
is an external controlled warehouse, print the
Transfer Order Report.

ShipmentProcess

* Perform material transactions that remove inven-
tory tied to these types of orders: Project, Job,
Customer Order, Purchase Order (with a negative
quantity), RMA, Production Order or Transfer Or-
der

* Run the Multi-Site Quantity Move utility

ShipmentSync
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User action to generate the BODNounVerb

Acknowledge the receipt of a ShipmentSchedule
from an external application

ShipmentScheduleAcknowledge

Acknowledge the receipt of a ShipToPartyMaster
from an external application

ShipToPartyMasterAcknowledge

* Change any information on the Customers form,
Ship Tos form, or Customer Sales Contact Cross
References form

ShipToPartyMasterSync

* Run the Change Reports To Entity utility

* Run the Copy Balances to Budgets utility

* Modify Chart of Accounts Budget and Plan infor-
mation

* Run the Rebalance Ledger Period Totals utility

* Run Ledger Posting for Journals

* Run the Mass Journal Posting utility

SourceSystemGLMovementSync

* Post journal entries to a ledgerSourceSystemJournalEntrySync

* Add or update Vendor information

* Update the vendor's address information

* Update Bank Address information

SupplierPartyMasterSync

* Perform a Transfer Order Ship

* Perform a Transfer Order Receive

* Perform a Combined Transfer Order Ship/Re-
ceive

TransferSync

Add a Work CenterWorkCenterSync
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Appendix E: Inbound BOD usage

This table shows the incoming BODs that CloudSuite Industrial can accept. It also indicates, when
possible, what area of CloudSuite Industrial shows the processed inbound data.

Destination of processed data in
CloudSuite IndustrialNounVerb

Bank Statements form, and A/P automatic
payments generated

BankStatementLoad

Engineering Workbench, Current Opera-
tions, Engineering Board

BillOfMaterialsProcess

Customers form and related formsBillToPartyMasterProcess

tmp_voucher_builder tableCaptureDocumentSync

chart tableChartOfAccountsProcess

Depends on type of codeCodeDefinitionProcess

Contacts form and related formsContactMasterProcess

currate tableCurrencyExchangeRateMasterProcess

Customers form and related formsCustomerPartyMasterProcess

Service order transactions, attendance,
project Labor transactions, unposted job
transactions (Indirect, Run or Setup)

EmployeeTimesheetSync

prtrx tableExpenseReportSync

Miscellaneous Receipt and Miscellaneous
Issue forms

InventoryAdjustmentSync

Miscellaneous Receipt and Miscellaneous
Issue forms

InventoryCountSync

Items form and related formsItemMasterProcess

Updates Vendor Paid YTD, Paid Fiscal
YTD and Last Paid Date

PayableTransactionProcess

coitem table (blanket items)PlanningScheduleSync

job tableProductionOrderProcess
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Destination of processed data in
CloudSuite IndustrialNounVerb

Estimates form and related formsQuoteProcess

N/APulseAlertAcknowledge

Updates Customer Posted BalanceReceivableTransactionProcess

If Type=”Transfer” and Status=”Received”
create transfer order receipt.

If Type=”Purchase Order” and Status=”Re-
ceived”create PO receipt

If Type=“Customer Return” create RMA
receipt

If Type=“Sales Order” create negative CO
receipt.

ReceiveDeliverySync

preq tableRequisitionProcess

Customer Orders form and related formsSalesOrderProcess

coitem or trnitem table (depending on
record type), last_external_ship-
ment_doc_id

SecurityUserMasterSync

If Type=“Transfer” and Status=”Shipped”
create Transfer Order Shipment

If Type=“Purchase Order” create Pur-
chase Order Return

If Type=“Sales Order” and Sta-
tus=”Shipped” create Customer Order
Shipment

ShipmentAcnowledge

coitem or trnitem table (depending on
record type), last_external_ship-
ment_doc_id

ShipmentSync

coitem table (blanket items)ShipmentScheduleSync

Customer Ship Tos form and related
forms

ShipToPartyMasterProcess
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Appendix F: BODs used in integrations with this
application

This section contains the list of BODs that are available for integrations with CloudSuite Industrial.

Outbound BODs from the ERP to integrated applications
This table shows the BODs that are available with CloudSuite Industrial. Where the application is blank,
the BOD is not currently used by interfacing applications, but the BOD is generated by CloudSuite
Industrial and is available to be processed through ION and any application that is set up to receive it.

To applicationsNounVerb

d/EPMAccountingChartSync

d/EPMAccountingEntitySync

SCE Warehouse ManagementAdvanceShipNoticeProcess

PLM AccelerateBillOfMaterialsAcknowledge

Infor Back Office ConnectBillToPartyMasterAcknowledge

CPQ/EQ

CRM

e-Commerce

Infor Back Office Connect

SCE Warehouse Management

BillToPartyMasterSync

d/EPMChartOfAccountsSync
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To applicationsNounVerb

CPQ/EQ

CRM

d/EPM

EAM

Expense Management

Infor Back Office Connect

PLM Accelerate

CodeDefinitionSync

CRM

Infor Back Office Connect

ContactMasterSync

CPQ/EQ

Expense Management

CurrencyExchangeRateMaster
Sync

Infor Back Office ConnectCustomerPartyMasterProcess

CPQ/EQ

CRM

e-Commerce

Infor Back Office Connect

PLM Accelerate

SCE Warehouse Management

CustomerPartyMasterSync

CRM

Infor Back Office Connect

CustomerReturnSync

CRM

e-Commerce

Infor Back Office Connect

InvoiceSync

PLM AccelerateItemMasterAcknowledge

CPQ/EQ

CRM

e-Commerce

Infor Back Office Connect

PLM Accelerate

SCE Warehouse Management

ItemMasterSync

CRM

e-Commerce

Infor Back Office Connect

LocationSync

Infor Back Office ConnectPayFromPartyMasterAcknowledge
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To applicationsNounVerb

CRM

Infor Back Office Connect

PayFromPartyMasterSync

CRMPersonSync

Expense ManagementPersonnelSync

Expense ManagementProductionOrderSync

Expense ManagementProjectMasterSync

Infor Ming.lePulseAlertProcess

EAM

SCE Warehouse Management

PurchaseOrderSync

CRM

Infor Back Office Connect

QuoteSync

CRM

Infor Back Office Connect

ReceivableTransactionSync

EAMReceiveDeliverySync

Expense ManagementRemittanceAdviceSync

EAMRequisitionAcknowledge

CRM

e-Commerce

Infor Back Office Connect

SalesOrderSync

Infor Ming.leSecurityRoleMasterSync

Infor Ming.leSecurityUserMasterProcess

Expense ManagementServiceOrderSync

SCE Warehouse ManagementShipFromPartyMasterSync

SCE Warehouse ManagementShipmentProcess

CRM

e-Commerce

Infor Back Office Connect

ShipmentSync

CPQ/EQ

CRM

e-Commerce

Infor Back Office Connect

SCE Warehouse Management

ShipToPartyMasterSync

d/EPMSourceSystemGLMovementSync
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To applicationsNounVerb

d/EPMSourceSystemJournalEntrySync

EAM

PLM Accelerate

SCE Warehouse Management

SupplierPartyMasterSync

PLM AccelerateWorkCenterSync

Inbound BODs to the ERP from integrated applications
This table shows the BODs that can be received and processed by CloudSuite Industrial. Where the
application is blank, the BOD is not currently used by integrating applications.

From applicationsNounVerb

PLM AccelerateBillOfMaterialsProcess

CRM

Infor Back Office Connect

BillToPartyMasterProcess

Infor Back Office ConnectCodeDefinitionProcess

CRM

Infor Back Office Connect

ContactMasterProcess

CRM

Infor Back Office Connect

CustomerPartyMasterProcess

Expense ManagementEmployeeTimesheetSync

Expense ManagementExpenseReportSync

SCE Warehouse ManagementInventoryAdjustmentSync

SCE Warehouse ManagementInventoryCountSync

PLM AccelerateItemMasterProcess

Infor Ming.lePulseAlertAcknowledge

CRM

CPQ/EQ

QuoteProcess

SCE Warehouse ManagementReceiveDeliverySync

EAMRequisitionProcess
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From applicationsNounVerb

CPQ/EQ

CRM

e-Commerce

SalesOrderProcess

Infor Ming.leSecurityUserMasterSync

SCE Warehouse ManagementShipmentAcknowledge

SCE Warehouse ManagementShipmentSync

CRM

Infor Back Office Connect

ShipToPartyMasterProcess
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